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of any correction if such be made. LSC recommends its customers obtain the
latest version of the relevant information to establish, before ordering, that the
information being relied upon is current.

Type Conventions Used in This Document

Convention Meaning or Use

Bold

Items in the user interface that you select or click. Text that you type
into the user interface.

<Italic>

Variables in commands, code syntax, and path names.

Ctrl+L

Press the two keys at the same time.

Courier

Code examples. Messages, reports, and prompts from the software.

Omitted material in a line of code.

Omitted lines in code and report examples.

L1

Optional items in syntax descriptions. In bus specifications, the
brackets are required.

@

Grouped items in syntax descriptions.

{13}

Repeatable items in syntax descriptions.

A choice between items in syntax descriptions.
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Introduction

Designs in any of the Power Manager devices can be implemented using the
PAC-Designer software tool. In addition, the PAC-Designer software provides
tools to simulate the power management design, download the design into a
device through parallel port or USB, and toggle registers in the device
dynamically during device operation. The PAC-Designer software can be
downloaded from the Lattice Web site free of charge.

Designing with the PAC-Designer software involves in the following main
steps:

Create/Open power management design

Configure analog input signals

Configure digital inputs

Configure digital output pins

Configure HVOUT pins (MOSFET driver outputs)

Configure Timer values

Configure 12C address

Implement power management algorithm using the LogiBuilder

© © N o 0 s~ wDd -

Simulate the design and iterate through steps 2 through 6

10. Download the design into a Power Manager device and verify the design

When the PAC-Designer software is installed, the set-up utility also installs a
number of design examples. You can access these examples by choosing
File > Design Examples in the PAC-Designer software. Details of the design
examples are described in <pac-designer_install_path>\Examples\Design
Examples.ppt.
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The next sections will describe each of the designing steps in detail using the
following design example:

¢ POWR1220AT8-2_cPCI_HS_Seq_RG_Sup.PAC — Complete board
power management for a CompactPCIl add-on card.

The features of this design example are listed below:

Design: CompactPCI Board Power Management Including Hot-swap
¢ 12V, 5V and 3.3V Hot-swap Controller (= LTC4245 IC)

Operate MOSFETs in Safe Operating Area (SOA)

Short Circuit Protection Individually On Each Supply Rail
Sequence Supplies: +12V, +5V, +3.3V & -12V (In That Order)
Protection Against Over Current Faults During Operation

Measure Voltage and Current Feed Individually on 12V, 5V & 3.3V
Supplies Through 12C

* & & oo o

¢ Interface to CompactPCl Backplane Logic Signals
¢ Sequence On-Board DC-DC Converters
¢ Monitor all Supplies for Faults & Generate Brown-out interrupt
¢ Shut Down All Supplies in Reverse Order
The power management block diagram is shown in Figure 1. Here the

ispPAC-POWR1220AT8 device is used to implement hot-swap, sequencing,
and reset generation functions.
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Figure 1: CompactPCI Design
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The top left and the bottom left portions of Figure 1 performs the hot-swap
function. The top right portion of the diagram is used to sequence supplies on
the board and the right side of the diagram interfaces to the board reset,
supervision and other control functions.

Creating/Opening a Design File

To create a new file:
¢ Choose File > New.

This opens a dialog box (Figure 2) that enables device selection.
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Figure 2: Selecting a Device for a New Design

New g]

Create a new document:
: al Far-out Buffer, Differantial
Zero-Delay Universal Fan-out Buffer, Differential

izpPAC-CLEREZ0N, Enhanced Zero-Delay Clock Generator with Univerzal Fan-out Buffer Cancel

ispPAC-CLERET 04, Enhanced Zero-Delay Clock Generator with Uriversal Fan-out Buffer -

ispPAC-CLER3Z20S Zero-Delay Universal Fan-out Bufer, Single ended

ispPAC-CLER3TES Zero-Delay Univerzal Fan-out Buffer, Single ended

ispPAC-CLER3125 Zero-Delay Universal Fan-out Buffer, Single ended

izpPaC-CLER302S Zero-Delay Universal Fan-out Buffer, Single ended

ispPAC-CLER3045 Zero-Delay Univerzal Fan-out Buffer, Single ended

ispPAC-POWERTZ204TS Supply Sequencing, Monitoring, Measurement, Trimming and b argining

ispPAC-POWRT2204TE-02  Supply Sequencing, Monitaring, beasurement, Trimming and kM argining (12

ispPAC-POVERTOT 44 Supply Sequencing, Monitoring and Measurement

ispPAC-POWRT0144-02 Supply Sequencing, Monitaring ahd Measurement [124]

ispPAC-POWRT014 Supply Sequencing, Monitaring

izpPaC-POWET0T4-02 Supply Sequencing. Monitaring [124]

LA-ispPAC-POWRT0T44 Supply Sequencing, Monitaring and Meazurement

LéqispPAC-POWR1014 Supply Sequencing, Monitoring

ispPAC-POWREATE Supply Measurement, Trimming, and b argining

ispPAC-POWR1208P1 Supply Sequencing/Precision Manitoring

izpPAC-POWERT202 Supply Sequencing/tonitaring

ispPAC-POWREDT Supply Sequencing/Maonitaring w

To open a file:
1. Choose File > Designh Examples.

This opens the dialog box shown below in Figure 3.

Figure 3: Opening a Design Example

Design Examples

Directary:  CAPAC-DesignerS3sExamples

Files:

ienClock54060-1- Dual FOR.PAC Title: Fan-out Buffer Implernentation with ispClock 54060
izpClock 54060 -2-Z0B. FAC

:zEElgzkEMDD-'I- Dual FOB.PAC Subject:  igpClockB406d as a dual-Fan-out Buffer
:zggggkgféggﬂig%irig%ht Author: Lattice Applications Group

ispPAC-CLEA308S_Demo. PAC
ispPAC-CLKS3125_Demo. PAC
ispPAC-CLKS3165_Demo. PAC

Device: izpPAC-CLER406D

ispPAC-CLKG3205_Demo. PAC Lomments:

ispPAC-CLIEET 08 _Denno. PAC This design implements o

i=pPAC-CLEAE208,_Dema PAC - Dual fanout buffer Bank, 0 to 1 distribute teh clock from Refé
POWR1014-02-1-55t_Seq RG_Supervisor PE Bankz2 ta Bank5 distribute the clock from RefB
POWR1014-1-55t_Seq RG_Supervisor PAC - Dutputs are configured as LVYDS -
POWwWR10144-02-2-HS-Contraller. PAC - Outputs from Bank O to Bank 1 are skewed using Time Skew Bloc
POwWR101 48-2-HS-Controller PAC - Dutptus are controlled using the OEw signal routed to User 3 pin
POWR10144-3_PCle HS_Seq RG_Sup.Pac -12C is not enabled

POWF10144-3 PCle HS_Seq RG_Sup B0l
POWR12204T8-1-55t_Seq RG_Sup_Tm.Pa
PO/ 2204T8-2_cPCI_HS_Seq RG_Sup.P
POW/R12204T8-3-LY_HS_Seq T_MPAC
POMWF12204T8-3-LY_HS_Seq T_M_BO.PAC
PO/ RE05-1_RG-MI PAC
POWREDS-2_RG-MIwWDT PAC
POWRENS-3-Superizor_FReset WDT_StrapS
POWREDT-1_RG_MIPAC

PO REDN7-2-RG_MA_WDT.FAC
POWREO7-3-Dual_RG_MFA_wDT PAC
POWREDT-3-Dual RG_MA_wWDT_G0.FAC
POWREQDT-4-neaatived 8 -hotswan. PAC

Open File LCloze
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2. Select POWR1220AT8-2_cPCl_HS_Seq_RG_Sup.PAC and click Open
File.

The software opens the schematic page shown below in Figure 4.

Figure 4: CompactPCI Design in POWR1220AT8

= PAC-Designer - [POWR1220AT8-2_cPCI_HS_Seq RG_Sup.PAC: Schematic]
u File Edit Yiew Tools Options ‘window Help

LexEHE 4 &

hargin/Trim

Analog Inputs

Digital Input=

W ouTi4
W OUTIS
——— ) QUTIG
— W auTiT
W ouT
L mouT
UES Bits = FFFFFFFF MCLE PLOGLE —— | ouTz20
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Configuring Analog Inputs

Analog inputs of the Power Manager device can be accessed by clicking the
Analog Inputs block shown at the top left corner of Figure 4 and the software
will open the schematic interface shown in Figure 5.

Figure 5: Analog Inputs Schematic Interface

»' PAC -Designer - [POWR1220AT8-2_cPCl_HS_Seq _RG_Sup.PAC: Schematic]
u File Edit Wew Tools Options Window Help

DS 4 aa

Analog Inputs

o.arsy

04_Limit

0075 —iﬂ— 4# S
? 4|—. Wi rd oo

T

£ 3

Double-click to go back to the main schematic page

This is the next level in the hierarchy that shows the comparators and the
associated voltage thresholds for each analog input. The outputs of the
comparator are connected to window logic and then to a glitch filter. The
output of the glitch filter is connected to the on-chip CPLD. The power
management algorithm is implemented in the CPLD.

To configure the analog inputs, double-click any of the comparators to open
the dialog box shown in Figure 6.
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Figure 6: Analog Input Settings Dialog Box
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The following parameters of each of the analog inputs can be accessed
through the dialog box shown in Figure 6. (The names of these parameters
are shown on top of each of the columns.)

¢ Pin Name — This is the name of the pin in the datasheet. This is a pull-
down menu that enables associating any VMON pin to a schematic net.

This feature can be used to accommodate changes required by the layout
stage, for example.

Schematic Net Name — Enter the name of the schematic. This can be
any alphanumeric character.

Logical Signal Name — There are two programmable threshold
comparators associated with each of the VMON pins. The names
specified here will be used in the power management algorithm. All
names should begin with a letter. No spaces are allowed. To concatenate
two words, use the “_ " (underscore). No other special characters are
allowed.

Monitoring Type — Over-Voltage / Under Voltage monitoring selection.
Each of the comparator can be used to monitor an over-voltage (OV) or
an under-voltage (UV) event. The difference between the OV and the UV
setting is location of hysteresis. For example, the OV comparator trips
exactly at the set threshold trip point when the voltage excursion is from

PAC-Designer Software User Manual 7
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low to high. Once tripped, the voltage has to drop below the hysteresis
level to toggle the comparator back. If under voltage is set, then the
comparator trips during the input voltage high to low excursion and the
hysteresis is applied during the low to high excursion.

¢ Trip Point Selection — This is a pull-down menu used to select the actual
trip point from a table of 368 trip points. The step size of these trip points
are spaced at 0.5% of the nominal voltage value that is monitored.

¢ 64 pys Glitch Filter — Each of the monitoring comparator can be
configured to ignore supply glitches narrower than 64 microseconds by
checking the associated box. This means that the output of the
comparator will transition only if the changed status remains active for a
period longer than 64 microseconds. If this box is not checked, then the
comparator output will toggle within 16 microseconds from the time the
voltage transitions through the appropriate trip point.

¢ Window Mode — There are two comparators associated with each VMON
pin, Comparator A, and Comparator B. To use the window mode, the
Comparator B threshold should be lower than the threshold setting of
comparator A. The window mode output will replace the comparator A
output. The window output is logical high if the Comparator B output is
high and the Comparator A output is Low.

After entering the values into all required fields of the dialog box, click the OK
button to update the design and transition into the intermediate schematic
with two comparators per analog input (Figure 5). Position the cursor outside
the schematic region until the cursor becomes an up arrow. Click the left
mouse button to transition to the main schematic shown in Figure 4.

PAC-Designer Software User Manual 8
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Configuring Digital Inputs

Starting at the main schematic page, click the Digital Inputs block to open the
secondary schematic shown in Figure 7.

Figure 7: Digital Inputs Schematic Interface

»' PAC -Designer - [POWR1220AT8-2_cPCl_HS_Seq RG_Sup.PAC: Schematic]
u File Edit Wew Tools Options Window Help
LDeEE 4 e a
Digital Inputs

From Fin

From JTAG

From Fin

From I2C

Fram Fin

From Fin

From I2C Register ]

From Fin

From I2C

From Pin D—‘

From I2C

£ 3

Double-click to go back to the main schematic page

This diagram shows six input buffers receiving the input from the input pin or
the internal 12C register. Click any input buffer to open a dialog box shown in
Figure 8.
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Figure 8: Digital Inputs Dialog Box

Digital Inputs

Pit Name Uzer-Defined Name Input Fram

=]
# Pin

N1 - ) Cancel
" UTAG Register
N2 -] [PCRST s L
" 12C Reaister
& [
Mz < [m2 Pin
" 12C Reqister
e < [na 7L
" 12C Register
=
s <] s Pin
" 12C Reqister
% Pin
INE - IME
| J | " 12C Register

This dialog box enables the configuration of input pin location, name of the
input pin for use in power management logic, and the signal source.

¢ Pin Name — This is the name of the physical pin in the datasheet. Any pin
can be assigned to the logical pin name (in this dialog box it is called
User-Defined Name) through the pull-down menu.

¢ User-Defined Name — This is the logical name used by the power
management algorithm implemented in the CPLD. The default association
of the physical pin can be changed by changing the Pin Name field.

¢ Input From — This associates the logical signal name specified in the
User-Defined Name field to either a physical pin or an internal register.

Note

IN1 is controlled by the JTAG register or the external pin. IN2 to IN6 can be
controlled by 12C register. Changing pin allocation also changes the register bit
associated with that input.

Click the OK button to navigate back to the schematic shown in the Figure 7.
From there, navigate back to the main schematic shown in Figure 4 by
double-clicking the blank space in the schematic shown in Figure 7.
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Configuring Digital Outputs

Double-click the Logic Outputs block on the bottom right side of the schematic
shown in Figure 4 to navigate to the next level schematic shown in Figure 9.

Figure 9: Logic Outputs Schematic Interface

» [PAC-Designer - [POWR1220AT8-2_cPCl_HS_Seq_RG_Sup.PAC: Schematic]
E File Edit Wew Tools Options Window Help

DS 4 e a

Logic Outputs

From PLD
—D RN IZV_Dowe

From 25

Brows_Ont N
From 25

From BC Reqk

DN_WEE_FET

¢ . 5
Double-click to edit this symbol

To configure logic outputs in a dialog box (Figure 10), click any output buffer in
the schematic shown in Figure 9.

PAC-Designer Software User Manual 11



PAC-Designer Software User Manual Configuring Digital Outputs

Figure 10: Logic Outputs Dialog Box

Logic Outputs

Pin Marne Lser-Defined Mame Digital Caritrel Fram lTl
E ® PLD " 12C Register Cancel
[ouTe |  PLD " |2C Register
[aut? | * PLD ¢ |2C Register
joute  w|  JEN_V3b ® PLD " 12C Register
[ouTs | |Local_PCI_Rst b & PLD " I2C Register
[auTin | falet b % PLD ¢ |ZC Register
[OUT11 | [Brown Out N ® PLD " |2C Register
[auTi2 | |CPU_ResetN  PLD " |2C Register
[outiz | [DrevEE_FET ® PLD " |2C Register
[outi4 | [ouTi4  PLD " |2C Register
[outis  +| [ouTis ¢ PLD " |2C Register
[ouTie | fouTis * PLD " |2C Register
jouTi7 «|  JouTi? ® PLD " 12C Register
[outie | fouTis  PLD " |2C Register
[ouTis  ~|  |ouTis  FLD " I2C Register
[oUTz0 ~|  |ouTa  FLD " I2C Register

With this dialog box (Figure 10), the output pin location, its logical name and
the signal source can be configured. In a POWR1220AT8 device there are 20
digital open drain outputs.

¢ Pin Name — This is the datasheet pin name. Use this field to associate the
logical pin name with any of the logical outputs.

¢ User-Defined Name — This is the logical name used by the power
management algorithm to toggle the corresponding output pin. Any user-
defined name can be associated with any logical pin through the use of
the Pin Name field.

¢ Digital Control From — The radio buttons determine whether the PLD
output or a register bit controlled by 12C interface drives the physical pin. If
an output is driven by the 12C register, the PLD outputs are ignored and
vice versa.

After updating the requisite outputs, click OK to navigate to the schematic
shown in Figure 9 and navigate to the main schematic page by double-
clicking the blank space in the schematic.
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Configuring HVOUT Pins (MOSFET Driver Pins)

Double-click the block called High Voltage Outputs located above the Logic
Outputs block to navigate into an intermediate schematic that shows FET
driver blocks (Figure 11). Double-click any FET Driver block to navigate to the
dialog box (Figure 12) that can be used to configure each of the HVOUT pins.

Figure 11: High Voltage Outputs Schematic Interface

» PAC-Designer - [POWR1220AT8-2_cPCl_HS_Seq_RG_Sup.PAC: Schematic]
H File Edit Wew Tools Options Window Help

DS 4 e a

Outputs

From PLD

From IZC gister

Fram PLD

From |20 Register

From FLD

From IZC gister

From PLD
HWVOUTS
From 12C

< >
Double-click to edit this symbol
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Figure 12: High Voltage Output Settings Dialog Box

High Voltage Output Settings @

Pin Mame Uzer-Defined Mame  Digital Cantral From COutput Setting kK |
{* Charge Pumnp Output Cancel
* PLD Yoltage: o -
H¥DOUT1 - 5 c "
¢ 12C Register ource Current; 1260l -
Sink Current: 100wt
" Open Drain Logic Dutput
{* Charge Pump Output
* PLD Yoltage: 1 -
HVOUTZ  «| |DRY_SV_FET
 I2C Register Source Cumrent; 125uh, =
Sink Current: 100w, -
" Open Drain Logic Dutput
{* Charge Pump Output
* PLD Yoltage: BY -
HVOUTZ  w| [DRV_12¥_FET
. Source Cument: 125u4  w
" 12C Register .
Sink Current: 100w, -
" Open Drain Logic Output
% Charge Pump Output
~ PLD Yoltage: =% -
aurce Current: . -
HVOUT4  =|  [HVOUT4 _ Source C Y
" 12C Register .
Sink Current: 100us
" Open Drain Logic Output

The dialog box shown in Figure 12 can be used to associate the physical pin
to a logical pin name, the output pin control, HYOUT pin’s voltage, source
current, and sink current. In addition, each pin can be configured as a
MOSFET driver or a logical open drain output.

¢ Pin Name — This is the name of the hardware pin in the datasheet. To

associate this pin with a different user-defined name, change the HVYOUT
pin name using the pull-down menu.

User-Defined Name — This is the logical pin name used in the power
management algorithm

Digital Control From — The radio buttons in this field determine whether
the logic equations within the PLD or the register bits in the 12C register
control the actual HYOUT pin.

Output Setting — The radio buttons determine whether the output pin is
configured as a high voltage pin or as an open drain logic output pin. If the
output pin is configured as a charge pumped high voltage pin, its
properties can be further changed:

¢ \oltage — The output voltage can be set to 12V, 10V, 8V, or 6V.

¢ Source Current — Determines the turn on slew rate. This can be set
to 12.5pA, 25pA, 50pA, or 100pA. The lower the current setting, the
slower the ramp rate.

¢ Sink Current — Determines how fast the MOSFET is turned off when
the output pin switches to Logic ‘0’. This can be set to 100pA, 250uA,
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500uA, or 3000uA. The higher the current, the faster the MOSFET
turn-off process.

Click OK to jump to the intermediate schematic (Figure 11) and double-click
the blank space to navigate to the main schematic (Figure 4).

Configuring Timers

The power management algorithm requires long duration timers. The Power
Manager device implements four hardware timers which can be configured
independently. Double-click the Timer block in between the Logic Outputs
block and the Logic Inputs block at the bottom to navigate to an intermediate
schematic shown in Figure 13.

Figure 13: Clock & Timers Schematic Interface

» PAC-Designer - [POWR1220AT8-2_cPCI_HS_Seq_RG_Sup.PAC: Schematic]
H File Edit Wiew Tools Options ‘Window Help

DEEHES & &a

250kHz

!

PLOCLK

<

Double-click to go back to the main schematic page

The above figure shows four timers and the clock source. Double-click any
Timer block to navigate to Clocks & Timers dialog box shown in Figure 14.
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Figure 14: Clocks & Timers Dialog Box

Clocks & Timers @

Master Clock Source [BMHz)
{* Standalone [Internal 0SC, MCLE pin High-2§

" Master [Intermal 0SC, MCLK pin used as output] Cancel

" Slave [External OSC)

PLDCIk Buffered Output
f* PLDCLK pin Enabled

" PLDCLK pin High-Z

Tirners

Timerl: W
Tirner2: lm
Tirner3: m
Tirmerd: Im

The Clocks & Timers dialog box can be used to configure three sections of the
Power Manager device.

¢ Master Clock Source — Configures the device as a standalone, master,
or a slave by selecting the radio button options:

¢ Standalone — Runs the device on its internal 8MHz oscillator. The
MCLK pin is tristated.

¢ Master — In this state this Power Manager device is a master and
sources the main 8MHz clock for all the devices. The clock source is
still its internal 8 MHz oscillator.

¢ Slave — This mode enables the Power Manager device to receive the
clock sourced from another master.

¢ PLD Buffered Clock Output — This radio button setting determines
whether the 250KHz clock output pin is tristated or not.

¢ Timers — This section enables time delay setting between 32
microseconds to 2 seconds (122 steps) for each of the timer through the
pull-down menu.

Click OK to update the configuration and transition to the main schematic via
the intermediate schematic shown on Figure 13.
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Configuring the 12C Block
In the main schematic (Figure 4), double-click the 12C block above the ADC
block at the top of the schematic to navigate to the following dialog box shown

in Figure 15.

Figure 15: Configuring the 12C Address & Controlling the Inputs/Outputs

12C Configuration @
I2C Address th = -
Carcel

1/0 pins can connect to PLD or be controlled by [2C readswrites

HYOUT FLD output drives pin

HYauTZ PLD output drives pin
HvOUT3 PLD output drives pin
HYOUT4 PLD output drives pin
auTs PLD output drives pin
ouTE PLD outout drives oin b

+ PLD 1/0 connected to pin

" 12C interface connected to pin

12C Alert Responze
[ SME Alert on OUTE [PLD output on OUTS is dizabled)

This dialog box is used to set the [2C address of the device between 0 and
7E. The 12C address is then programmed into the device and the
PWOR1220AT8 device responds to that address.

The Input and output pin control through 12C can also be set from this dialog
box in addition to the input and output block dialog boxes.

The POWR1220AT8 device supports the SMBAlert mechanism and this can
be enabled by selecting the option.

Navigate to the main schematic by clicking the OK button.

PAC-Designer Software User Manual



PAC-Designer Software User Manual Implementing Power Management Algorithm in LogiBuilder

Implementing Power Management Algorithm in
LogiBuilder

After configuring all inputs and outputs, the next step is to implement the
power management algorithm. For that, begin by double-clicking the
Sequence Controller block at the middle of the schematic (Figure 4). The
software navigates to the LogiBuilder window shown in Figure 16.

Figure 16: LogiBuilder Window for Sequence and Supervisory Logic

= PAC-Designer - [Design3: Sequence and Supervisory Logic]

: File Edit Wiew Tools Options ‘Window Help -8 X
LD EHE ¥ o FINS e
| Step | Sequencer Instruction Qutputs | Ink... | Cammenk
SMO Step O Eegin Startup Sequence g
SMO Step 1 Wait for AGOOD no
SMO Step 2 Beqin shutdown Sequence no
SMO Step 3 Halt {end-of-program}) no
< 4
Exception ID | Boolean Expression Oukputs Exception Handler Commenk
<end-of -exception-table =

SMO
Equation | Supervisory Logic Equation | Macrocell Configuration Commenk
<gnd-of-supervisory-logic-table =
< 3
Ready

This window is divided into 3 sections:

¢ Sequence Control — Enter a sequence of events and actions in the
power management algorithm. There can be more than one sequence
control algorithms. Each of these sequence control algorithms executes in
parallel. The sequence control algorithm is made up of a number of steps.
Each of these steps contains an instruction. The sequence control engine
executes each of the instructions using the 250KHz PLD clock. Some of
the instructions get executed in one clock cycle or 4us while some
instructions require many cycles.

¢ Exception Control — This can be considered as an interrupt to the
sequence control flow. Each sequence control algorithm has a separate
Exception Control section.

¢ Supervisory Logic Equation — This enables implementation of logic
made up of equation that can run in parallel with the sequence control
logic.

PAC-Designer Software User Manual 18



PAC-Designer Software User Manual LogiBuilder - Sequence Control

LogiBuilder - Sequence Control

The Sequence Control section is the top window of the LogiBuilder window
shown in Figure 16. There are 5 columns in this section:

e Step — This is the step number of a given instruction. This step number is
used by the branching instructions.

¢ Sequencer Instruction — There are basically six different instruction
types: Output, Wait for, If-Then-Else, Go to, Start/Stop Timer, and NOP.
Each of these instructions along with its application is described later.

Outputs — This section specifies only the output pins that are toggled.

¢ Interruptible — If this is marked as No, the exception condition is ignored.
If it is marked Yes, then any of the exception condition, if becomes true,
can force a branch to the exception routine.

¢ Comment — Enter comment for documentation.

Entering Power Management Algorithm into the Sequence Controller
The power management algorithm is entered into the Sequence Controller by
inserting an instruction at a given step. The next step is to double-click that
new instruction to open a dialog box and enter the required parameters in it.

To introduce a new instruction at any step, highlight that step number and
press the Insert key. The software opens a dialog box shown in Figure 17.

Figure 17: Inserting a New Sequence Control Instruction at a Given Step

Insert Step @

Inzert a Sequence Controller Step

~
it for <Boolean condition: Cancel

it for <timeout value:

W ait for < Boolean condition: witk Timeout

Halt

HOF

16/ Then/Elze

16T hen/Elze with Timeout

[Efalis]

Start Timer 45

You can set parameters of the instruction after it is created.

After inserting an instruction, it can be customized to perform the required
function. For example, Figure 17 shows the Outputs instruction highlighted.
Click the OK button, this outputs instruction will get inserted at that step. After
inserting that step, double-click that instruction to open a new dialog box in
which you can select all the outputs that should be turned on or off.

Introducing the expressions into Exception condition and Supervisory
Equations sections are similar. The steps are as follows:

¢ Select the line on which the expression should be entered and double-
click it to open a dialog box. Customize it and close the dialog box.
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Entering a Program into the Sequence

Controller

When the LogiBuilder window is launched, the Sequence Controller starts
with four instructions:

¢ Begin Startup Sequence — The sequencer enters the first step when the
device is powered on. The first time when the control enters this step, all
outputs are reset to their respective power-on reset values. Other than
that this is essentially a marker step and does not perform any other
useful task. This step can be deleted.

¢ Wait for AGOOD - This is one of the Wait for instruction types.
Immediately after power-on, the PWOR1220AT8 initiates analog
calibration process. After the completion, the analog section activates the
AGOOD signal internally. All comparator outputs are valid only after the
AGOOD signal is at logic HIGH. In this step the Sequence Controller waits
for the completion of analog calibration before proceeding with the next
steps.

¢ Begin Shut Down Sequence — This step performs two functions: marker
step indicating that the power shut down sequence is found after that step
and when you double-click this step, it automatically allows insertion of an
instruction into that step and the shut down sequence marker moves to
the next step. For example, in Figure 16, the Begin Shut Down sequence
marker is at step 2. By double-clicking step 2, you can insert an instruction
at step 2 and the Begin Shut Down sequence marker moves one step
down to step 3. This marker can be deleted to reduce the number of
steps.

¢ Halt (End of Program) — This instruction is a special case of the Go to
instruction where the sequence jumps to the same step as that of the
instruction. In this case the Halt instruction is at step 3. When the
Sequence Control enters this step, it stays at this step for ever. However,
if the Interruptible flag was set to Yes, then an exception condition can
transfer it to another step.

Sequencer Instructions
This section describes the instructions supported by the LogiBuilder.

Output Instruction

Action: This instruction controls the output pins of the Power Manager
device. The output status is maintained until it is changed again either through
another output instruction or through the output section of any other
instruction.

Purpose: This is used functions such as turning a supply on/off or activating/
deactivating a supervisory signal or turning a MOSFET on/off.

The Output instruction is inserted into a sequence control step through the
Insert key on the keyboard and selecting the raw Output instruction. Figure 18
shows the Sequence Controller with the raw Output instruction at step 2.
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Figure 18: Sequence Controller with Raw Output Instruction at Step 2

»' PAC-Designer - [Design1: Sequence and Supervisory Logic] g|
: File Edit Yiew Tools Options ‘window Help = | & x
L=zES o || E FIbS =l B B
| Step | Sequencer Instruction Outputs | Int | Comm

Eiegin Startup Seguence

SMO Step 1 Wait For AGQOD yla]
SMO Step 2 <no oukputs specified = ro
SMO Step 3 Begin Shutdown Sequence no
SMO Step 4 Halt {(end-of-program) no
< >
Exception I | Boolean Expression | Cukputs Exception Handler Comment

<end-of-exception-table =
< >
SMO
Equation | Supervisory Logic Equation Macrocell Configuration Cormnmenk

<end-of-supervisory-logic-table =

The next step is to configure the raw Output instruction through a dialog box
(Figure 19) that can be opened by double-clicking the raw Output instruction.

Figure 19: Configuring the Output Instruction in a Dialog Box

Edit “Output™ properties

Outputs
Cancel

oure ]
In use: [ Change thiz output signal this instruction
Fin Type: Registered, JE-type flip-flop

Set Value: " Tum on / Aszert

% Tum off / Deaszert

Excephions: ¥ Instruction is inkeruptible by an exception

Comment Dutput instruction demaonstration

The top window shows all outputs of the Power Manager device. Any output
can be turned on / asserted / set to logic high or turned off / deasserted / set to
logic low through the radio button. In Figure 19, the HYOUT2 output is turned
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»' PAC-Designer - [Design1: Sequence and Supervisory Logic]

on and the OUT5 output is turned off. When the OK button is clicked, the step
2 of the sequence control output is changed to show (Figure 20) the operation
on HVYOUT2 and OUTS5 signals. There is no limit to the number of instructions
that can be turned on or off in a given instruction.

Figure 20: Output Instruction Configured at Step 2

BEE

: File Edit Yiew Tools Options ‘window Help s
= - | =2 = =

LeEES om || E FIHS 5] B B3
Step | Sequencer Instruction | Outputs | Int... | Comment

SM0 Step O Eeqgin Startup Sequence no iSpPAC-POWR1Z20ATS reset

SMO Step 1 ‘Wait For AGDOD g

SMO Step 2 DUTZ =1, QUTS =10, YES Oukput instruckion dermonstr ation
SMO Step 3 Begin Shutdown Sequence no

SMO Step 4 Halt {end-of-program) no

< >
Exception I | Boolean Expression | Cukputs Exception Handler Comment

<end-of-exception-table =

< >
SMO

Equation | Supervisory Logic Equation Macrocell Configuration Cormnmenk

<end-of-supervisory-logic-table =

< >
Ready

The check box next to the exceptions can be checked to indicate whether this
instruction can be interrupted by the exception condition or not. In this
example, the output instruction can be interrupted.

The Comment section can store any text that will appear in the Comment
section of the Sequence Controller at that step.

“Wait for” Instruction
The “Wait for” instruction type includes three sub types.

¢ Wait for <Boolean> — Causes the sequence controller to stall at that step
until the Boolean expression becomes true. The Sequence Controller
jumps to the next step after the Boolean expression becomes true.

Wait for <Timeout Value> — Starts the timer and waits at that step until the
timer expires. The Controller proceeds to the next step after the timer
expires.

Wait for <Boolean> with Timeout — Starts the timer and waits for the
Boolean condition to become true until the timer expires. If the Boolean
condition becomes true within that time period, the Sequence Controller
jumps to the next step. However, if the timer expires before the Boolean
expression becomes true, the Controller jumps to a different location
determined by the instruction.
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Wait for <Boolean>

Application: This instruction is used to turn a supply on and hold the
Sequence Controller at a step for a power supply to reach its regulation
levels.

This instruction is first inserted as raw into a step using the Insert key on the
keyboard. Double-click the raw “Wait for <Boolean>" instruction to open the
following dialog box (Figure 21) for configuring the “Wait for <Boolean>"
instruction.

Figure 21: Edit “Wait For Bool” Properties Dialog Box

Edit *Wait For Bool" properties

Instruction Preview

Instruction Oukputs
Wit For <BooleanExpr =

Edit Boolean Expression... Outpuk Contral..,

v Instruction is interruptible by an exception

Cammenk

In the dialog box, click Edit Boolean Expression to open the following dialog
box (Figure 22).

Figure 22: Boolean Expression Editor
Boolean Expression Editor m

Boolean Expression 0

K. |
Cancel

AND OR NOT xorn | (] |

Double-click to add available items to expraszion

Care_1W2_over_LTF

I0_1W8_0K

10_1%8_aver LTP

WhAOM3_A

WhON3_B

WhAOM4_A

YiAONA B b

Any Boolean function can be created using any of the input or output signals
by the following process.

1. Double-click the required input signal to transfer it to the Boolean
Expression window. First, double-click the Core_1V2_over_LTP signal.

2. Click an operator button. Click AND.
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3. Double-click the IO_1V8 over_LTP signal.

At this point the dialog box shown in Figure 22 will be as shown in Figure 23.

Figure 23: Entering a Boolean Expression

Boolean, Expression Editor

Boolean Expression

Core_1W2_over LTP AND 10_148_over LTH

AND OF NOT | %OR

[].4 |
Cancel

Double-click to add available items to expreszion

Core_1W2_0FK
Core_1W2_over_LTF
10_1wE 0K

Click OK to return to the Edit “Wait for Bool” properties dialog box as shown in

Figure 24.

Figure 24: Edit “Wait For Bool” Properties Dialog Box Showing the

Newly-Added Logic Equation

Edit *Wait For Bool" properties

Inskruckion Presvigws

Instruction
wWait For Core_1WZ_over _LTP AND IQ_1YS_over_LTP

| Edit Boolean Expression, ..

[V Instruction is interruptible by an exception

Comment

Oukputs

Cutput Conkral.,,

Cancel

o] 4
&=

Next, click Output Control to open the Edit “Output” properties dialog box
shown in Figure 25. This is the same dialog box as that of the Output
instruction. Here the core supply (1.2V) enable and IO supply (1.8V) enable

signal are turned on.

PAC-Designer Software User Manual

24



PAC-Designer Software User Manual LogiBuilder - Sequence Control

Figure 25: Turning on 1.2V and 1.8V Supplies Using the Edit “Output”
Properties Dialog Box

Edit “Qutput” properties

Outputs

DK |
HwouTZ = Cancel

Core_1W2 En=1
10 18 En=1

In uze: [ Change thiz output signal this instruction
Fin Type: Reaistered, JK-type fip-flop
Set Value: " Turn on / Aszert

* Tumn off / Deassert

Exceptions: B

Comment

Next, click OK. The “Wait for Boolean” instruction gets updated, as shown in
Figure 26.

Figure 26: Wait for <Boolean> Instruction Getting Updated

Edit *Wait For Bool" properties

Instruckion Preview K

Instruction oukpuks

Wait For Core_1%2_over _LTP AND IO_1YS_over_LTP Core_1VZ2_En=... Cancel
Edit Boolean Expression. .. Cutput Conkral,

[ Instruction is interruptible by an exceptiong

Comment

Turn on 1.2% and 1.5 supplies and wait For them to reach requlation

Enter the comment and indicate whether this instruction is interruptible via
exception condition and click OK. The Step 3 in the Sequence Control section
is modified as shown in Figure 27.
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Figure 27: Sequence Control Section Showing the Updated “Wait for
<Boolean>" Instruction

= PAC-Designer - [Design1: Sequence and Supervisory Logic]
: File Edit Yiew Tools Options ‘Window Help

DS ¥ e 5| PINS =l & B

Step | Sequencer Instruckion | Outputs | Int... | Cammenk

SMO Skep O Begin Skartup Sequence no ispPAC-POWR12Z0ATS reset
SMO Skep 1 Wait for AGOOD no

SMO Skep 2 ] Cubput instruckion dermonskr sk
S0 Skep 3 e LTP ARD IO W ] ] Turn on 1.2 and 1.5 supplies
SMO Step 4 Begin Shutdown Sequence no

SMO Step S Halt {end-of-program) no

< >
Exception ID | Boolean Expression | Oukputs Exception Handler Commenkt

<end-of-exception-table >
I| smo
Equation | Supervisory Logic Equation | Macracel Configuration Zarnmenk
<end-of -supervisory-logic-table =

< >
Ready

When the Sequence Controller executes step 3, it first turns on core supply
(1.2Vv) and 10 supply (1.8V) and waits until the output voltages of both
supplies reach the regulation levels.

Wait for <Timeout Value>

Application: This instruction is used for functions such as: wait a certain
period for a supply to stabilize after turn on or time based sequencing or to
extend the reset pulse after all supplies are turned on.

This instruction is edited by using the following dialog box shown in Figure 28.
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Figure 28: Edit “Wait for Timeout” Properties Dialog Box

Edit “Wait for Timeout™ properties E|

Timeout:

b, ns
Timer 2 1966 08ms timeout
Timer 3 1966.08ms timeout
Timer 4 196E.08mz timeout

Cancel

Edit Timeout properties... |

Outputs

Output Contral

[ Instuction iz inkeruptible by an exception

Camment

The first step is to select the timer used for implementing the timeout delay. It
is possible to change the value of the time delay from this dialog box by
clicking Edit Timeout properties to go to the Clocks & Timers dialog box
shown in Figure 14. It is possible to enable outputs along with this step. For
example, in Figure 29, the Timer 1 (5.12ms duration) is started and the 1.2V
core supply is also turned on. The Sequence Controller waits in that step till

the Timer 1 expires.

Figure 29: Wait for Timeout to Turn on the Supply & Wait for 5.12ms

Edit *Wait for Timeout™ properties E|

Timeout:
Cancel

5.1 2ms timeout
Timer 2 1966, 08ms timesout
Timer 3 1966.08ms timeout
Timer 4 1966, 08ms timeout

Edit Timeout properties... |

Outputs
Core_1W2_En=1

Output Contral

[ Ingtuction iz inkeruptible by an exception

Comment Turn 1.2¥ supply and wait for 5.12 ms

By clicking OK and adding another “Wait for timeout” instruction and an
Output instruction, the Sequence Controller program is shown in Figure 30.
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Figure 30: Program to Turn on Supplies in a Sequence & Release Reset

» PAC-Designer - [Designi1.PAC: Sequence and Supervisory Logic]

: File Edit “iew Tools Options ‘Window Help -

D dES W e | E PIlE = &= B

Step | Sequencer Instruction | Cukputs | Int... | Comment |
SMO Step 0 Beqgin Startup Sequence no ispPAC-POWR1220ATS reset

SMO Step 1 ait For AGOOD Core_1%Z En=0,I0_I¥S _ En=0, Reset_CPU=0, no Start with all supplies turned off and ...
SMO Step 2 ‘Wait For 5. 12ms using tirer 1 Core_1¥2 En=1, no Turn 1.2Y supply and wait For 5,12 ms
SMO Step 3 ‘Wait For 212.99ms using timer 2 I0_1¥5_ En=1, no Turns on 1.8% and waits For 200 ms

SMO Step 4 Reset CPU =1 no

SMO Step 5 EBegin Shutdown Sequence

SMO Step 6 Halt {end-of-program) no

Exception I0 | Boolean Expression | COukputs Exception Handler Comment

=end-of -exception-table =

SM0
|| Equation | Supervisory Logic Equation | Macrocell Configuration Comment
<end-of-supervisory-logic-table =
Ready

At step 1, the Sequence Controller is waiting for the AGOOD signal (or waiting
for the completion of the analog calibration). While waiting, 1.2V, 1.8V
supplies are turned off and the reset to CPU is active. When the AGOOD
signal becomes active, the Sequence Controller jumps to step 2.

As soon as the code enters step 2, the 1.2V supply is turned on and the 5ms
timer (Timer 1) is also turned on. The Sequence Controller waits until the 5ms
timer expires and jumps to step 3.

At step 3, the 1.8V supply is turned on and Timer 2 (200ms) is started
simultaneously. The Sequence Controller waits at step 3 for 200ms (until the
timer 2 expires) and jumps to step 4.

At step 4, the CPU reset is released. The Sequence Controller transitions
through step 5 without any action and stops at step 6.

Wait for <Boolean> with Timeout

Application: The Wait for Boolean instruction waits for the Boolean function
to become true indefinitely. For example, if a power supply fails to turn on, the
Sequence Controller can be stuck at that Wait for Boolean instruction. Some
devices cannot withstand being left partially turned on for a very long period of
time. To deal with such cases, Wait for Boolean with Timeout instruction is
used. This instruction turns on a supply and waits for a fixed period of time for
it to turn on. If the supply fails to turn on, the Sequence Controller times out
and jumps to shut down that section of the design.

This instruction is edited by the Edit “Wait For Bool with Timeout” properties
dialog box shown in Figure 31.
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Figure 31: Edit “Wait For Bool with Timeout” Properties Dialog Box

Edit *Wait For Bool with Timeout™ properties

Instruction Preview

Timeout if above condition iz not satizfied by this time

Tirner 1 2 timeaout
Timer 2 212.93ms timeout

Instruction Outpuits

Wait for Core_1%2_over LTPAND 10_1%8 over LTPor5.. Coe_1¥2 En=_. Cancel
IF Timeout
Then Gota &

Edit Boolean Expressian. . Output Contral...

Edit Timeout properties. .. |

Timer 3 1966 08ms timeout
Timer 4 1966.08ms timeout

™ Instruction is intermiptible by an exception

Comment

On Timeout Goto Sequencer step | Step B - with Dutputs. ..

off

IF1.2% supply does not turn on within 5 mg, jumnp to shut down and turm all supplies

This instruction turns on the 1.2V supply and starts the 5ms timer
simultaneously. After that, it waits for the 1.2V and 1.8V (assuming the 1.8V
was turned on previously) supplies to reach regulation. If the supply turns on
before the timer expires, the Sequence Controller moves to the next step. If
the 5ms timer expires, the program jumps to shut down routine.

Figure 32 shows a program with this new instruction.

Figure 32: Program Using the Wait for Boolean with Timeout Instruction

» PAC-Designer - [Designi.PAC: Sequence and Supervisory Logic]

:| File Edit Wew Tools Options Window Help

b HES oo % | E PR BN =
Step | Sequencer Instruction | Qukputs | Int... | Comment |
SMO Step 0 Beqgin Startup Sequence no ispPAC-POMWR1Z220ATS reset
MO Skep 1 Wait For AGOOD Core_1%¥Z En=0,I0_I¥S En=0, Resst_CPU=0, no Skart with all supplies turned off and ...
MO Step 2 ‘ait For 5. 12ms using timer 1 I0_1¥G_En=1, no Turn 1.8% and wait For Sms
SMO Step 3 Wait For Core_1%Z _over LTP AMD IO_1WS_over LTP... Core_IWZ En=1, no IF 1.2% supply does not
IF Timeout turn on within 5 ms, jurmp
Then Goto & ko shut down and turn all 5.,
SMO Step 4 Wait For 212,99ms using kimer 2 no
SMO Step 5 Halt Reset_CPU=1, Seq_Err=0, no Realse reset and keep the system on
MO Step 6 Begin Shutdown Sequence no
S0 Core 142 En=0, IO _1¥8 En=10, Seq Err =1 no There was a supply Fault, shut all su...

Halt {end-of-program)

Exception ID | Eoolean Expression Cukpuks E:xceplion Handler Camment

=end-of -exception-table =

SMO0

I| Equation

| Supervisory Logic Equation | Macrocell Configuration Comment

<end-of-supervisory-logic-table =
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At step 1, the program waits for the calibration process to complete with all
supplies tuned off.

At step 2, the 1.8V supply is turned on and simultaneously the Timer 1 (5ms)
is also started. The Sequence Controller waits at step 2 for 5ms after turning
on the 1.8V supply and jumps to Step 3.

At step 3, the 1.2V supply is turned on and simultaneously the Timer 1 is
restarted. The Sequence Controller waits for the 1.8V and 1.2V supplies to
reach regulation within 5ms. If both supplies reach regulation within 5ms, the
Sequence Controller jumps to step 4, where it waits for 200ms and jumps to
step 5. At step 5, the Sequence Controller halts with the reset signal released.
The sequence error flag is cleared. The circuit board functions normally.

However, at step 3, if the supplies did not reach regulation levels before 5ms,
the step times out and jumps to step 6 to begin the shutdown operation. The
code jumps to step 7.

At step 7, both the supplies are turned off and the Seq_err flag is turned on
indicating that the board failed to sequence.

“Start/Stop Timer” Instruction

Application: The previously described “Wait for Timeout” instruction starts
the timer and waits for it to expire in that same step. In some cases, you may
want to just start the timer at one step and check on it at a completely different
step. For example, you can implement a watchdog timer function where a
timer is started at one of the steps and the sequence control can monitor for
timer expiry at a different step while performing different functions.

There are 2 sub types of timer control instructions:
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Start Timer

The Start Timer instruction is used to start a given timer through the dialog
box shown in Figure 33.

Figure 33: Start Timer Dialog Box

Start Timer

Timeout:

5.12ms timeout
Timer 2 212.99ms timeout Caticel
Timer 3 136E.08ms timeout
Timer 4 1966, 08ms timeout

Edit Timeout properties... |

Outputs

Core_1W2 En=1 Cutput Control |

[ Instuction iz inkeruptible by an exception

Comment  [Tig ctarts the imer and tums the sUpply on

simulatanioushy

Select the timer that should be started in the top section of the dialog box. you
can change the timer value by clicking Edit Timeout properties. It is also
possible to alter any output status. In this case, the Timer 1 is started and the
1.2V supply is turned on at the same time. The Sequence Controller jumps to
the next step. Re-execution of Start Timer during a sequence control
algorithm stops and restarts the same timer.

Note

The Stop Timer instruction step cannot be a target of branch instruction.
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Stop Timer

The Stop Timer instruction stops the timer. It can be configured using the

following dialog box. (Figure 34)

Figure 34: Stop/Reset Timer Dialog Box

Stop/Reset Timer

Timeout:

5.12ms timeout
Timer 2 212.99ms timeout Caticel
Timer 3 136E.08ms timeout
Timer 4 1966, 08ms timeout

Edit Timeout properties... |

Outputs

Cutput Control

[ Instuction iz inkeruptible by an exception

Comment

“If-Then-Else” Instruction

There are 2 types of If-Then-Else instructions.

¢ If-Then-Else — This instruction checks for a Boolean expression. If it is
true, it goes to the step indicated by the Then section. If the Boolean
expression is false, it jumps to a different branch indicated by the Else
section. This instruction is used to control the flow of the sequence control
program. Along with that this instruction can also activate different outputs

depending the Boolean logic status.

¢ If-Then-Else with Timeout — This instruction, in addition to functioning like
the instruction above, checks on a timer expiry and provides a third
branch address with another output control section.

If-Then-Else

Application: This instruction can be used to poll different inputs and perform
different functions depending on the inputs. For example, the Sequence
Controller can monitor supply voltages and branch to shut down routine and
poll for an input condition, and jump back to monitor voltages.

The If-Then-Else instruction can be configured using the dialog box shown in

Figure 35.
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Figure 35: Conditional Branch (IfThenElse) Dialog Box

Conditional branch (IfThenElse)

Inskruckion Presyiews
Instruction Oukputs
If Care_1%2_OK AND IO_1V8_OF Cancel
Then Goto 4
Else Goto A
Edit Boolean Expression, .. | Cukput Conkral,,
Then Gato - with Outputs |

Else Goto Step & A with Oukputs |

[ Instruction is interruptible by an exception

Comment

If the supplies are OF jump to check the reset input, IF the suppleis are faulty, jump
to shut down

The Boolean expression is set by clicking Edit Boolean Expression as

shown in the Figure 23. In this case the sequence engine is monitoring for the

core voltage of 1.2V and the 10 supply of 1.8V. If either supply is faulty, the

sequence control jumps to the shutdown section of the sequence control
program (step 6). Otherwise it jumps to the next step (step 4).

It is possible to change any output during the branch transition by clicking

with Outputs associated with the Then and the Else branches.

The following sequence control program (Figure 36) uses two If Then Else

instructions to poll the supply fault and input reset signal and performs
different functions depending on the input conditions.
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Figure 36: Sequence Controller Polling Digital Input and Supply Fault

» PAC-Designer - [Designi.PAC: Sequence and Supervisory Logic]

:| File Edit Yew Tools Options Window Help -0 x

L=eEd&E o | 5| E PIHE = B B
Step | Sequencer Instruckion | Cutputs | Ink... | Commenk |
SMO Step 0 Beqgin Startup Sequence no ispP&C-POWR 1220ATS reset
SMO0 Step 1 Whait For AGOCOD Core_1WZ En=0, I0_1¥S En=0, Reset_CPU=0, no Skart with all supplies turned off and ...
SMO Step 2 Skart kimer 1 (5.12ms) Core_1¥2 En=1, I0_I¥8 En=1, no This starts the tirmer and turns the su...
SMO Step 3 IF Core_1¥2_ QK AND IO_1YS_ K no If the supplies are QK jump

Then Goto 4 ta check the reset input,

Else Goto & If the suppleis are faulty, ...
SMO Step 4 If Reset_in no This Checks for the reset

Then Goto 3 with { Reset_CPU=1, } input and changes the CPU

Else Gota 3 with { Reset_CPU=10, } reset signal depending on k...
SMO Step S Begin Shutdown Sequence no

Core_1%2 En=0, 10 1¥8 En=0, Seq Err=1 o There was a supply fault, shut all su..,
SMO Step 7 Halt {end-of-program})
Exception I | Eoolean Expression | Jutputs Exception Handler Comment
<end-of-exception-table >
SM0
Il Equation | Supervisory Logic Equation Macrocel Configuration Comment
=end-of-supervisory-logic-table =
Ready

Step 1 — The sequence control program waits for the analog calibration.

Step 2 — Both 1.2 and 1.8V supplies are turned on and the program waits for
5ms.

Step 3 — If the supplies are faulty, jumps to the shutdown program, turns off
both supplies, flags error and goes to halt. If the supplies are OK, then jumps
to step 4.

Step 4 — If the Reset_in signal is at logic 1 then Reset_ CPU = logic 1 else,
Reset_CPU signal = Logic 0.

If-Then-Else with Timeout

Application: (This instruction assumes that the timer is started beforehand
using the Start Timer instruction). This instruction is used to monitor a number
of events with one watchdog timer. For example, in a circuit board a number
of supplies can be turned on and these supplies should all be stable within a
certain period of time. If they fail to turn on, the shutdown function is initiated.
This instruction can also be used to implement a watchdog timer in a system.

The If-Then-Else with Timeout instruction can be configured using the
following dialog box (Figure 37).
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Figure 37: Edit “IfThenElse with Timeout” Properties Dialog Box

Edit “IfThenElse with, Timeout™ Properties

Imstruction Preview

Instruction Outpuits
If <booleanE wpre
Then Goto 0 Cancel
Elze If Timer 1
Then Gota 0
Elze Goto O

Edit Boclean Expression... | Output Contral...
On Condition Goto Sequencer step Step 0 - with Qutputs

Timeout if above condition iz not zatizfied by this time

Timer 1 5.1 2ms limeout — -
Timer 2 212.99ms timeout Edit Timeout properties... |

Tirmer 3 1966, 08ms timesout
Timer 4 136E.08ms timeout

On Timeout Goto Sequencer step Step 0 - with Outputs
Elze Goto Sequencer step Step 0 - with Outputs

[ Instruction is intermiptible by an exception

Carmnmient

The test Boolean function along with the outputs to be toggled during the step
is entered as described from Figure 21 to Figure 24.

The instruction first tests the Boolean condition to be true. If the Boolean
condition is true, then it branches to the step indicated by the pull-down menu
next to “On Condition Go to Sequencer step”.

If the Boolean condition is false, the instruction tests the timer expiry. If the
timer has expired, the Sequence Controller branches to the step indicated by
the pull-down menu next to “On Timeout Goto Sequencer step”.

If the timer has not expired, the Sequence Controller branches to the step
selected by the pull-down menu next to “Else Goto Sequencer step”.

Each branch condition can be set to toggle different sets of outputs
independently through the Output Control button.

The following sequence control program (Figure 38) uses the If-Then-Else
with Timeout instruction.
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Figure 38: Using If-Then-Else with Timeout in a Hot-Swap Application

» PAC-Designer - [POWR1014A-02-2-HS-Controller.PAC: Sequence and Supervisory Logic] E@@
: File Edit “iew Tools Options ‘Window Help - O
L& ¥ o FIHG e
- Pin Definitions
Step | Sequencer Instruction Cutputs I—rrrrv.—l | Commenk | -~
SMO Step 0 Beqgin Startup Sequence YES ispP&C-POWR 1014 reset
SMO Step 1 ait For AGOOD no
SO Step 2 Turn_MOSFET _On_Fully = 0, Skark_HotSwap With S04 =0 o D niok skark: the Hot-swap until the s...
SMO Step 3 Stark timer 1 (106.50ms) Stark the Debounce Timer {Set timer. ..
SO Step 4 IF Inp_3%3_OK AND Inp_SY_OK no 5y and 3.3% Supplies are
Then Goto 4 Stable for Debounce
Else If Timer 1 period, So start HotSwap
Then Goto 5
Else Goko 1
SMO Step S Start_HokSwap_Wikh_S08 = 1, no
SO Step & ‘Wait For Brd_3%3_OK AND Brd_SY_OK or 2,05ms using Timer 2 yes Ensure 3.3% and 5% turn on
TF Tirmennik within snecified Hie *
| Exception ID | Boalean Expression | Outputs | Exception Handler Commment =
SM0
I| Equakion | Supervisory Logic Equation | Macrocell Configuration | Carnment L
EQO H5_3¥3_MOSFET_Drive,D = { NOT I_3¥3_Over_S0&_Li...  Qutput, registered, D Fip-flop Hot swap in S04 or Turn the MOSFE..,
EQ1 H5_5v_MOSFET_Drive.D = { MOT I_SY_Ower_SOA_Limit ... Output, registered, D Flip-flop Hot swap S supply or Fully turn on
EQ 2 H5_3W3_MOSFET_Drive.ar = I_3¥3_Ower_Current OR 1., OQutput, reqgistared, D Fip-flop Ttip Bath MOSFETs if Any CurrentE...
EG3 H5_5Y_MOSFET_ Drive.ar = I_3%3_Ower_Current ORI_...  Output, registered, D Fip-flop Ttip Both MOSFETs if Any Current E... v

User names, logic polarity, output type

When a circuit board is plugged into a backplane, during initial stages of
contact there will be a contact bounce. The backplane has two supplies: 3.3V
and 5V. During the contact bounce period, the 5V and 3.3V supplies will be
intermittent. This routine waits until the contact bounce settles and then
proceeds with the hot-swap event.

Step 0 — Marker.

Step 1 — Waits for the calibration.

Step 2 — Initialization of various outputs.

Step 3 — 100ms timer is started using the Start Timer instruction.

Step 4 — The If-Then-Else with Timeout instruction checks to see if the 5V and
3.3V supplies are within limits. If not, the program jumps to restart the timer.
(Notice that the program branches to a step previous to that of the Start Timer
instruction). If the supplies are within tolerance, the code waits at the same
step until the timer expires. When the timer expires, the code jumps to the
next step. This instruction ensures that the backplane voltage is continuously
on for 100ms before jumping to the hot-swap portion of the code.
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“Go to” Instruction

This is a branch control instruction. The target jump location can be specified
using the dialog box shown in Figure 39.

Figure 39: Edit “Goto” Instruction Properties Dialog Box

Edit “Goto™ instruction properties E|
Step nurmber
Step 0 > Cancel
Outputs
COutput Control

[ Instruction is intermiptible by an exception

Comment

The target Goto step can be set using the Step number pull-down menu. You
can set the outputs also along with this instruction.

“NOP” Instruction

The NOP instruction basically does nothing. This instruction is necessary to

enable a branch to terminate in a step previous to a timer control instruction,
such as the Wait For Timeout, Start/Stop Timer, or If-Then-Else with Timeout
instructions.

Figure 40: Watchdog Timer Implementation

» PAC-Designer - [Design1.PAC: Sequence and Supervisory Logic]
:| File Edit Wew Tools Options Window Help !

= = oo | 05| E FIHE = B B

Step | Sequencer Instruckion | Cutputs | Ink... | Commenk |
SMO Step 0 Beqgin Startup Sequence no ispP&C-POWR 1220ATS reset

SMO0 Step 1 Whait For AGOCOD WDT_Intr=1, no Skart with all supplies turned off and ...

SMO Skep 2 MOP no

SMO Step 3 Start timer 3 (524.29ms) no This starts the timer and turns the su...

SMO Step 4 IF MOT WDT_Trig WDT_Intr =1, no ‘Wathcdog timer

SMO Step 5

Then Gota 2
Else IF Timer 1

Then Goto 2 with { WwDT_Intr=0, }

Else Goto
Halt {end-of-program)

Exception I | Eoolean Expression | Jutputs Exception Handler Comment
<end-of-exception-table >
SMO
Il Equation | Supervisory Logic Equation Macrocel Configuration Comment
=end-of-supervisory-logic-table =
Ready
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Step 0 — No action.

Step 1 — Waits for the calibration to complete and sets the watchdog timer
output to logic 1.

Step 2 — NOP does nothing.
Step 3 — Starts a 500ms timer.

Step 4 — If WDT _Trig signal is 0, restarts the 500ms timer. If the timer expires,
sets the interrupt to logic 0 and restarts the timer. If the WDT_Trig signal is at
logic high, waits at the same step until the trigger reaches 0 or the timer
expires.

As you see, the NOP instruction provides a method to restart the timer by
overcoming the limitation of no direct jump allowed to a timer control
instruction.

“Halt” Instruction

The Halt instruction stops the execution of the sequence. The last Halt
instruction is normally prevented to preserve a fail-safe stopping point for a
sequence. In cases where sequence flow is controlled by other means, the
last Halt instruction in the sequence window can be deleted. You can enable
the deletion of the last halt instruction by choosing Options > LogiBuilder
Options in a LogiBuilder window (Figure 41). The following dialog box will
open.

Figure 41: Allowing Deletion of the Last Halt Instruction

LogiBuilder Options il
Sequence Optimization
[~ Allow deletion of the last Halt instruction
Cancel |

State Machine Encoding
(8 Binary
(" Gray

Flip Flop Synthesis
w Default (O/T -Type)
(" D-Type
~ T-Type

Select the “Allow deletion of the last Halt instruction” option and you will no
longer be prevented from deleting any Halt instruction.
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LogiBuilder - Exception Conditions

So far the sequence control window of the LogiBuilder was described. The
next section of the LogiBuilder window is Exception Condition. Exception
conditions are used to interrupt the Sequence Controller flow to enable the
sequence control program to respond differently to an external stimulus
without looking for it in the main sequence code. The Exception Condition
section of the LogiBuilder window is shown in the Figure 42.

To show the use of the exception conditions, the watchdog timer design in
Figure 40 is modified to monitor for supply failure while monitoring for
watchdog timer, as shown in Figure 42.

Figure 42: Exception Condition Section in LogiBuilder

»|PAC -Designer - [Figure_40_Exception condition.PAC: Sequence and Supervisory Logic] @
"] File Edit Wiew Tools Options Window Help = | & x
D rool|% =
FIHS
Step | Sequencer Instruckion Cukputs | Int... | Cammenkt

Begin Startup Sequence

Else I Timner 3
Then Goto 4 with { WDT_Intr =10, }

SM0 Step 1 iait for AGOOD Core_1WZ2_En=1,I0_I¥3... no Start with all supplies turnes

SMO Step 2 Wait for Core_1V2_OK AMD IO_1WS_OK Core_I¥2_En=1,I0_1¥3... no Turn on all supplies and wai

SMO Step 3 Wit for 212,99ms using timer 2 no Start reset pulse stretch

SMO Step 4 Reset P =1, no Release CFU Reset

SMO Step S Start kimer 3 (524, 29ms) no This starks the timer and tu

SM0 Step & IF MOT Core_1V2 Ok OR NOT I0_14YS_0K WDT _Inkr =1, yes ‘Wait Far supply Faulk or
Then Goto & wakrchdog tiemr expiration

Else Goto 7
SMO Step 7 Reset_CPU =10, no
SM0 Step & Halk (end-of-program) no
< ¥
Exception I0 | Boolean Expression | Qukputs Exception Handler Cornrment
EO IF NOT WDT_Trig <no oukputs sp,,, Skarks ak step 4
<end-of -excepkion-table =
Exception Condition section of the LogiBuilder
SMD
Equation | Superyisory Logic Equation | Macracel Configuration Cormrment
<end-of-supervisory-logic-table =
The sequence control in Figure 42 is as follows:
Step 0 — Start up marker.
Step 1 — Waits for the calibration with all supplies turned off and with reset
CPU active.
Step 2 — Turns on the 1.2V and 1.8V supplies and waits for them to reach
regulation levels.
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Step 3 — Waits for 200ms.
Step 4 — Releases CPU reset to complete the reset pulse stretch function.
Step 5 — Starts/Restarts the 500ms watchdog timer.

Step 6 — Monitors for failure of the 1.2V and 1.8V supplies as well as
watchdog timer fault. If a power supply fault is detected, the Sequence
Controller jumps to shut down with the reset activated. If the watchdog timer
expired, toggles the WDT _Intr output signal, jumps back to step 4, restates
the watchdog timer at step 5, and resumes fault monitoring at step 6.

So how the watchdog timer is re-triggered?

This is handled by the exception condition. The step 6 has the interruptible
flag enabled. This means that the exception condition can interrupt the
sequence control flow. The watchdog trigger input is being monitored by the
exception condition EO.

The EO is monitoring for a low going pulse of the watchdog timer. When it
happens, the sequence control program is forced to jump to step 4 (the step
before the restart of watchdog timer) and the code restarts the time in step 5
and jumps to step 6 to resume monitoring for voltage fault and the expiration
of the watchdog timer.

Creating an Exception Condition

To create an exception condition, double-click <end of exception-table> or
select the end of exception table and press the Insert key.

The LogiBuilder inserts a raw exception condition as shown in Figure 43.

Figure 43: Exception Condition Fresh Entry: EO

» PAC-Designer - [Design?: Sequence and Supervisory Logic] @gj
: File Edit Wiew Tools Options window Help = || X
D= EES ¥ e
b 1. | [2l) B ik
Step | Sequencer Instruction | Qut A
SMO Steo O Beain Startuo Seduence h?
»
Exception ID | Boolean Exprassion Qukputs Exception Handler | 4
EOD If <booleanExpr > <no oukputs sp,..  Skarts at skep 0

<end-of-exception-table =

< >
Equation | Supervisory Logic Equation Macrocell Configuration
£ >
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To configure the exception condition, double-click EO and edit the dialog box
as shown in Figure 44.

Figure 44: Exception Properties Dialog Box

Exception properties

Expression which tiggers the exception:

Edi...

Cancel

E=ception will make sequencer go ta StepO =

[Jump only occurs when instruction iz Intermuptible)

Outputs controlled by exprezsion

[Outputs are active at all times; inkermuptible fag iz ignored).

Ih use: [ Change this output signal

SetWalue: " Asynchronously set to 1 when expression is ue. [RS FF)
" Asprchronously set to 0 when expression is true, [RS-FF)
™ Syrchronously follows expression. [D-FF]

* Synchronouzly follows inverse of expression. [D-FF Emulation)

Camment

The first step is to enter the exception condition Boolean equation. To do this,
click Edit on the top section of the dialog box to open the Boolean expression
builder shown in Figure 23.

The next step is to identify the step that the Sequence Controller should jump
to when the Boolean condition becomes true.

It is possible to toggle an output during the exception condition. The output
value can be changed asynchronously (similar to activating the asynchronous
set or reset of a D flip-flop) or synchronously (similar to changing the D-input
of the D flip-flop). The next example shows how the output control can be
used in a design.

In the example shown in Figure 42, the exception condition looked into a low
going signal of watchdog trigger input. This design has one problem. If the
processor hung with the WDT_Trig stuck at logic 0, the watchdog trigger
mechanism does not recover. For that the exception condition is modified to
trigger only on the falling edge of the WDT _Trig input in its logic equation.

To capture the falling edge of the WDT-Trig signal, a second exception
condition is used. The second exception condition latches the trigger signal
into another register Latch_Wdt_Trig (an internal node. The procedure to
creating an internal node is described later in this section). Figure 45 shows
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the Exception properties dialog box to implement latching of the WDT-Trig
signal.

Figure 45: Exception Properties Dialog Box Showing the Latching of the
WDT-Trig Signal into a Node

Exception properties [71

E=pression which triggers the exception:
WDT_Trig Edit...
Cancel

Eception will mak e sequencer go to hot used =

[Jump only occurs when instruction iz Intermuptible)

Dutputs contralled by expression

[Outputs are active at all times; intenmuptible flag iz ignored).

TIMER3_GATE ~

TIMER4_GATE

MHODET

I Lize: ¥ Change this output signal

SetValue: 7 Azpnchronously st to 1 when expression is tue. (RS FF)

™ Asprchronously set to 0 when expression is true, [RS-FF)

' Synchronously follows expression. [D-FF]

" Synchronouzly follows inverse of expression. [D-FF Emulation)

Cormment nal iz latched into Latched WD T_Trig Node

In this figure the logic expression is WDT_Trig signal. The exception condition
location is not used as there is no exception function specified. In the outputs
controlled by the expression section, the Latched_WDT_Trig node is
selected. The selected logical operator is “Synchronously follows the
expression (D-FF)". This operation converts the Latched_WDT_Trig into a D-
FF with its data connected to the WDT-Trig signal and is clocked by the
250kHz clock that is clocking the Sequence Controller.

Now the original logic expression in the exception logic EO shown in Figure 42
is modified to recognize the falling edge of the WDT_Trig signal instead of just
logic 0. Figure 46 shows the modified logic in the exception condition EO.
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Figure 46: Exception Condition Modified to Trigger at the Falling Edge of

WDT-Trig
= PAC-Designer - [Figure_40_Exception condition.PAC: Sequence and Supervisory Logic] @@@
: Fil= Edit Wiew Tools Options window Help - 8| X
DS o |5 E
pus e | B B2 B
Step | Sequencer Instruction Qutputs | Ink... | Caomment

SMIO Skey Eeqgin Starbup Sequence [ C 25
SMO0 Step 1 Wit for AGOOD Care_LVZ_En=1, I0_1¥8... no Start with all supplies turnes

SMO Step 2 wait for Core_1VZ_OK AND IO_1YS_0OK Caore_LVZ_En=1, I0_1¥8... no Turn on all supplies and wai

SMO Step 3 ‘Wit For 212,99ms using timer 2 no Start reset pulse stretch

SMO Step 4 Reset_CPl=1, no Release CPU Reset

SMO Step S Start timer 3 (524, 29ms) no This starts the timer and ki

SMO Step & IF NOT Core_1WZ2_OK OR NOT I0_1W8_0K WDT_Inkr =1, ves ‘wait for supply Faulk ar
Then Goto & wakrchdog tiemr expiration

Elze If Timer 3
Then Goto 4 with { WDT_Intr =10, }

Else Gota 7
SMO Step 7 Reset_CP =10, no
SMO Step 8 Halt {end-of-program) no
< >
E:xception ID | Boolean Expression Oubputs Exception Handler Commenk
ED If MOT WDT_Trig AMD Latched DT _Trig <m0 oukputs sp,., Starts at step 4 Activated at the Faling edas of WDT...
E1l If WDT_Trig Latched_WDT_... notused WDT-Trig signal is latched into Latch. ..

<end-of-exception-tabls =

SMO

Equation | Supervisory Logic Equation Macrocel Configuration Cormrmenkt
<end-of-supervisory-logic-table =

The logic expression EO now looks at condition when the WDT_Trig signal is
low and the Latched_WDT_Trig signal at logic high. This condition is true for 4
microseconds and occurs only at the falling edge of the WDT _Trig signal.

LogiBuilder - Supervisory Logic

This section is provided to add additional logic functions that are independent
of the sequence control into the CPLD part of the Power Manager device. In

some cases, the Supervisory Logic section can be used to implement power
management functions taking up fewer CPLD resources.

In this example, the supervisory logic equations are being used to implement
a 10 second duration timer using the hardware timers. This long duration
timer is required for monitoring the initialization section of the processor
program on the circuit board.

This section describes the timer operation to facilitate understanding of long
duration timer function implemented in the Supervisory Logic section.
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Hardware Timer Architecture Implemented in Power Manager Device
When Timer_gate is at logic high, the hardware timer in the Power Manger
counts down from a preloaded value (programmable from 32us to 2 seconds)
to 0 and generates a Logic 1 on the Timer_TC signal as shown in Figure 47.

Figure 47: Power Manager Timer Operation

Frogrammable
— Timer— —
Timer Gate 272Us to 2 Sec Timer TC

Timer Gate
Timer TC

—»  Programmed Time Delay .-q—

If the gate signal toggles to zero while the timer is counting down, the timer
delay value gets reloaded and the count down restarts.

There is a special mode of operation of the timer where the timer gate is
connected to an inverted Timer TC signal. In this case, the timer TC signal
generates a 4 microsecond pulse train separated by the time delay
programmed into the Timer (in this case it is 2 seconds). The connection and
the output waveforms are shown in Figure 48.

Figure 48: Generating a Train of Pulses 4us Wide and Separated by 2

Seconds
Frogrammable
Timer —
Timer Gate 3 San Timer TC
(
Timer ate Jj
p— 25ec —
TimerTC (¢

«I |-—4us JJ
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Ten-Second Timer Implementation Using the Supervisory Logic Section
Refer to Figure 49. To insert a new supervisory equation, EQO, double-click
<end-of-supervisory-logic-table> or place the cursor on the last line in the
Supervisory Logic window and press the Insert key.

Figure 49: Supervisory Logic Section in LogiBuilder

= PAC-Designer, - [2 Minute Timer .PAC: Sequence and Supervisory Logic] @g|
: File Edit Yiew Tools Options ‘Wwindow Help = | &
DeES b=
FIHS =] =4 B
Skep | Sequencer Inskruction Oukputs | Int. .. |A
SMO Step O Beqgin Startup Sequence no
SMO Step 1 Wait for AGOOD no
SMO Step 2 Beqgin Shutdown Sequence no
SMN Sken 3 Halr {end-nf-nranranmt rin 4
>
- e - - - - -
< >
SMO
Equation | Supervisory Logic Equation racrocell Configuration Zarmrmenkt
EQO HYOUT1 = =boolzanExpt = Output, registered, ¥ flip-flap
<end-of-supervisory-logic-table =
Supervisory Logic section of the LogiBuilder
< >
Loading data inta list view...

The supervisory equation representation is divided into 4 parts: the equation
number (automatically generated), the logic equation (a Boolean expression
assigned to an output pin or node), type of assignment (Combinatorial, D-
type, T-Type, Asynchronous Preset, and Asynchronous Reset), and a
comment line for documentation.

To enter the actual supervisory logic equation, double-click the newly
introduced supervisory equation to open the dialog box shown in Figure 50.
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Figure 50: Supervisory Logic Equation Entry Dialog Box

Supervisory Logic Equation Entry
DOutput Macrocel
|TIMER1_GATE Output, registered, D fip-flop ~|

Cancel

Type of aszignment

|0UTsD = <BoolExpr> (D input] -]

Boolean Espression

MOT TIMER1_TC Edit...

Camment: Generating a pulse train of 4us wide seprat

To enter a supervisory logic equation, select the output that should be
controlled by the logic equation. Here the output selected is the Timer_Gate of
timer 1.

To generate a pulse train that is 4us wide and spaces 2 seconds apatrt, the
Timer_Gatel should be connected to its Timer_TC through an inverter
(Figure 48).

So, select type of assignment as D-type.

Next, click the Edit button to open the Boolean Expression Editor shown in
Figure 22. Here the assigned Boolean expression is Not Timerl_TC.

Click OK. The LogiBuilder window gets updated as shown in Figure 51.
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Figure 51: Supervisory Equation to Generate a Pulse Train 4us and 2
Seconds Apart

» PAC-Designer - [2 Minute Timer .PAC: Sequence and Supervisory Logic] Z §|g|
g X

") Elle Edit View Tools Options ‘Window Help iy
OD=E S ¥ om
s | (£ 521

| Qukputs | Int... | Cammer A

Skep | Sequencet Instruckion

Exception ID | Boolean Expression | Cukputs Excepkion Handler | Camment |
<end-of-exception-table =

SM0

Equation | Supervisory Logic Equation tacracell Configuration Commenk

EGO TIMER1_GATE.D'= MOT TIMERL_TC Output, registered, D Flip-Flop Generating a pulse train ol
<end-of-supervisary-logic-tablz =

< >

Loading data into list view. ..

A 10 second timer requires a 3-bit counter that counts the 4us pulses. The 3-
bit counter is implemented three internal nodes (Bit0, Bitl, and Bit2). The
method to create nodes is described later. Nodes are internal variables and

are not output to pins.

The Ten_second_Out pin generates a 4 microsecond wide signal once every
10 seconds. The supervisory equations are shown below in Figure 52.
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Digital Timing Simulation Using PAC-Designer

Figure 52: 10-second Timer Implementation Using Supervisory Logic
Equations

» PAC-Designer, - [2 Minute Timer .PAC: Sequence and Supervisory Logic]

: File Edit Wiew Tools Options ‘Window Help

D= EHS

PIHE

=l B

W o

EEX

| Sequencer Instruction

| Qukputs

| Int... | Cammer A

Exception ID | Boolean Expression | OutpUts Exception Handler

| Camment

<end-of-exception-table =

SMO

Equation

| Supervisory Logic Equation

Macrocell Configuration

Camrmenk

EQO
EQ1
EQ2
EQ3
BG4
EQS
EQ6
EQ7

<
Ready

TIMER1_GATE.D'= MOT TIMER.1_TC
Bit0. T = TIMERI_TC

Bit1.T = TIMER1_TC AMND EitD

Bit2, T = TIMER1_TC AMD EitD AND Eit1

Ten_Second_out,Dr = Bit2 AMD NOT Bitl AND BitD AMD T...

BitD.ar = Ten_Second_out
Bitl.ar = Ten_Second_out
BitZ,ar = Ten_Second_out
<end-of-supervisory-logic-table =

Output, registered, D Flip-Flop
Mode, reqgistered, T Flip-flop
Mode, reqgistered, T Flip-flop
Node, reqistered, T Flip-flop
Output, registered, D Flip-flop
Node, registered, T Flip-flop
Node, registered, T Flip-flop
Mode, reqgistered, T Flip-flop

Generating a pulse train ol
Bit 0 of the counter

Bit 1 of the counter

Bit Z of the counter

10 second timer output
Reset counter to restart o
Restark counker

Restart counter

EqO — Generates pulse train 4us wide and 2 seconds apart

Eql - Bit O of the counter that counts the 2 second pulse train

Eqg2 — Bit 1 of the counter that counts the 2 second pulse train

Eqg3 — Bit 2 of the counter that counts the 2 second pulse train

Eqg4 — Ten_second_out signal generating a 4us pulse once in 10 seconds

Eg5 — Restarts the bit O counter after 10 seconds

Eqg6 — Restarts the bit 1 counter after 10 seconds

Eq7 — Restarts the bit 2 counter after 10 seconds

Digital Timing Simulation Using PAC-Designer

To simulate a design with Lattice Logic Simulator, the design must first be
entered or edited using both the schematic windows and the LogiBuilder

Sequence Editor.

Next, a stimulus file should be created or edited using the Waveform Editor.
The stimulus file is used by the simulator, which produces a graphical output
that is viewed using the Waveform Viewer.
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To start Lattice Logic Simulator from within PAC-Designer:
1. In LogiBuilder, choose Tools > Run PLD Simulator.
The Launch Simulator Dialog Box opens.
2. Inthe Stimulus File box, browse to the desired stimulus file.
3. Click OK.

The PAC-Designer software will remember this stimulus file. Future
simulations can be initiated by clicking the PLD Simulator button on the
toolbar without bringing up the Launch Simulator dialog box.

The Waveform Editor is a graphical application that is used to create and edit
.wdl files. Each waveform is given a user-defined name, and then edited to
show transitions. The Waveform Editor uses a data model called the
Waveform Description Language (WDL). The language represents a
waveform as a sequence of signal states separated by time intervals. The
language also has constructs that let you express the waveform pattern
hierarchically. However, it is not necessary to be familiar with the Waveform
Description Language to use the Waveform Editor.

In order to start the Waveform Editor from a project that has been saved, an
ABEL file must exist. ABEL files are usually produced by compiling a
LogiBuilder design. ABEL files may also be generated by the user, either in
PAC-Designer or using a stand-alone text editor. The Waveform Editor scans
the ABEL file to determine the names of the input and output signals in use. If
the project has not been saved, then an ABEL file can be selected manually
after the editor has been started by choosing File > Import ABEL Design.

To start the Waveform Editor, choose Tools > Run Waveform Editor or click
the Waveform Editor button on the PLD Toolbar. The Waveform Editor looks
at the contents of the ABEL file for the current design in order to determine the
names of the input stimulus signals. This occurs automatically when the
Waveform Editor is launched from a PAC design that has been previously
saved.

If the Waveform Editor is launched from a design that has not been saved, an
ABEL file must be manually selected. To do this, select File > Import ABEL
Design. This will launch a file browser dialog box. Select the desired ABEL
file and click Open.

When the simulation is complete, the results are stored in a binary file (.bin)
and the Waveform Viewer application is launched automatically. The
Waveform Viewer starts with the design.bin file loaded, and displays the
signals that were defined in the stimulus file. The nhames of the waveforms
that are added to the display are stored in a .wav file, so that the added waves
will be displayed the next time you start the Waveform Viewer. This timing
example shown in Figure 53 was created from the “POWR607-

1 RG_MI.PAC” example file in PAC-Designer.
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Figure 53: Waveform Viewer Showing the Simulation Stimulus

BS Waveform Viewer - POWR6G07-1_RG_MI _ 0] x|
File Edit View Object Tools Options Jump Help

=a| 8| 21220 # BE| #|~| 2]

0.0 us 2 50 100 150 200

CPU_RESET | =
MANUAL_RESET_INPUT
INP_1VB_OK
INP_2V5_OK
INP_3V3_OK

INP_5Y_OK

RESET| |

CLK_IN

-
4 [« | >

Time = 388.0 us

You can edit and modify waveforms with the Edit Waveform dialog box. The
contents of the dialog box will change based on which waveform is selected.
You can launch this dialog box by double-clicking a signal in the Waveform
Editor or by choosing Edit > Waveforms and then double-clicking the signal
name in the Waveform Editor dialog box as shown below.

Figure 54: Edit Waveform Dialog Box

Edit ¥MON2_A Waveform

‘waveform Name IVMDN2_-‘3-

Initial State [t1] Index Lewel Duwration Tatal Time Cancel

= HIGH

* LOw

Add Segment

el
Delete Segment |

Seqgment Duration | 0 ue Change Segment |

When the dialog box is first opened, no parts of the waveform for its signal are
defined. The waveform is built by appending segments to the end of the list.
The state of the first segment is defined by the options under Initial State. To
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create the first segment, set the option as appropriate, type in the duration of
this initial state in the Segment Duration box, and click Add Segment.

The state of the subsequent segments is always the opposite of the state of
the last segment on the list. For instance, if the initial segment (t1) was
defined to be low, then t2 will be high, t3 will be low, and so on. Each new
segment is created by entering its duration into the Segment Duration box
and clicking Add Segment. Any segment listed in the Edit Waveform dialog
box may be deleted by selecting it from the list and clicking Delete Segment.
When this operation is performed, the states of all subsequent waveform
segments will invert.

The duration of any segment listed in the Edit Waveform dialog box may be
changed. To do this, select the segment and enter its desired duration in the
Segment Duration box. Then, click Change Segment. When you finish
making changes to the segment list, click OK to commit the changes to the
waveform.
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Implementing Multiple State Machines

The LogiBuilder supports multiple state machines for power up sequence and
control for some Power Manager devices. The state machines are defined
separately but can interact through nodes or common logic functions. Each
state machine is built up in a separate tab in the Sequence and Supervisory
Logic window. The logic for the full design is then compiled and fitted to
generate a single JEDEC file. Figure 55 shows the “POWR1220AT8-

2 _cPCI_HS_Seq RG_Sup.PAC” example file from PAC-Designer with the
Sequence and Supervisory Logic window open.

Figure 55: Sequence and Supervisory Logic Window Showing an
Example Design

Wl POWR1220AT8-2_cPCI_HS_Seq_RG_Sup.PAC: Sequence and Supervisory Logic [_ (O] x| I

[Step  |Sequencerinstrucion  oupus  [m.[comment |
SMO Step 0 Wait for AGOOD AND NOT BD_Sel_b Wait for Board Sel signal to become acti...
SMO Step 1 Shut_12V_Down = 0, Local_PCI_Rst_b =0, Alert_b ... no  Enable the Hotswap operation
SMO Step 2 If Brd_12V_OK AND Brd_3V3_OK AND Brd_5V_0OK no +12V, 3.3V and 5V should be

Then Goto 3 stable by this time
Else If Timer 1 Otherwise shut down
Then Goto 7
Else Goto 2
SMO Step 3 Drv_VEE FET =1, no
SMO Step4  Wait for 106.50ms using timer 1 no  Wait for VEE to settle
SMO StepS  Local PCI_Rst_b=1,Aert b=1, no  Release Local PCI Reset and Alert Signal
SMO Step 6 Wait for NOT Brd_12V_OK OR NOT Brd_3V3_0OK OR... no  Look for faults
SMO Step 7 Shut_12V_Down = 1, Enable_HotSwap = 0, no
SMO Step8  Halt (end-of-program) no
Exceptio... | Boolean Expression | QOuftputs | Exception Handler | Comment |

<end-of-exception-t...

SMO0: cPCl Hotswap ] SM1: On Board |

Equation | Supervisory Logic Equation | Macrocel Configuration | Comment |
EQO TIMER4_GATE.D = NOT Charge_Pump_Stre... Output, registered, D fip-flop  Reftrigger 12V MOSFET Char...
EQ1 Charge_Pump_Stretch.D = TIMER4_TC Node, registered, D fip-flop Need to Keep MOSFET Gate ...
EQ?2 DRV_12V_FET.D = (NOT I_12V_Over_SOA... Output, registered, D fip-flop  Operates MOSFET in SOA Be...
EQ3 TIMER1_GATE.D = ( Enable_HotSwap AND ... Output, registered, D fip-flop  If Supplies Dont Turn on wit...
EQ 4 DRV_3V3_FET.D = ( Brd_5V_OK AND NOT L.. OQufput, registered, D fipflop 3.3V MOSFET starts Hotswa...
EQS DRV_5V_FET.D = (Brd_12V_OK AND NOT IL.. Output, registered, D flip-flop 5V MOSFET starts hotswap ...
EQ6 DRV_3V3_FET.ar = NOT Enable_HotSwap Output, registered, D fip-flop  Turn-off MOSFET in case of f...
EQ7 DRV_SV_FET.ar = NOT Enable_HotSwap Output, registered, D fip-flop  Turn off 5V MOSFET before ...
EQ 8 DRV_12V_FET.ar = NOT Enable_HotSwap Output, registered, D flip-fliop

<end-of-supervisory-logic-table>

Note the upper sections contain the details for state machine SMO. This is
because the SMO tab (above the logic equations) has been selected. Clicking
the SM1 tab would open a similar view for the SM1 state machine.

The MSM Manager dialog box is used to add or delete state machines. To
open the dialog box, make sure the Sequence and Supervisory Logic window
is open, and the Sequencer Instructions table or the Exceptions table is
active, and then choose Edit > Multiple State Machines. Multiple state
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machines are supported for the Sequencer Instructions table and the
Exceptions table only. The settings in the Supervisory Equations table always
apply to the entire design.

Figure 56 shows the MSM Manager dialog box opened using the
POWR1220AT8-2_cPCl_HS Seq_RG_Sup.PAC example design.

Figure 56: MSM Manager Dialog Box

MSM Manager m

State Machines

Sk 0: cPCl Hotswap Contraller Add SM

S 1; On Board Management 4|

Delete Sk

State Machine Name: IOpen 3rd Shd

(0] I Cancel |

To add a state machine, selecting the place where you want to enter the next
state machine, enter the name for the new state machine, and click Add SM.
The window for sequence control will open. Note that the additional state
machine has been created and opened for code edit. After the editing, the
design can be recompiled and processed as discussed elsewhere in this
manual.

Designing Trimming and Margining Networks Using PAC-Designer
Determining the required resistor topology involves finding a solution for a
number of nodal equations and an understanding of the error amplifier
architecture of the DC-DC converter. In addition, the design can be iterated
until the solution yields standard resistor values.

The PAC-Designer software automates the process of determining the
resistor topology while using standard resistors in the resistor network.
Calculating the resistor values is a two-step process:

1. Create a DC-DC Converter Library using the DC-DC converter’s feedback
and trim section characteristics. This uses a few parameters commonly
specified in a DC-DC converter datasheet.

2. Attach a DC-DC converter to a Trim Cell. Calculate the resistors for a
given output trim and margin voltage specification for that DC-DC
converter.
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Creating a DC-DC Converter Library Entry

To create a DC-DC converter library entry:

1. To create a DC-DC converter library entry, open the POWR1220AT8
design and click the DC-DC button on the Margin toolbar to open the DC-
DC Converter Model Selection dialog box. In the dialog box, click New,
enter the name of the DC-DC module (for example, Murata_1V2_POL),
and click Next to open the Select DC-DC Converter Type dialog box.

Figure 57: Adding a DC-DC Converter into the Library

w' PAC-Designer - Designi
File Edit Wiew Tools Options ‘Window Help
hEEdES 48 aq

» Design1: Schematic r
DC-DC Conver e Mudel Selection

ispPAC-POWR1220AT8

DC-DC Libray =cld=r:

ConFAL-Desigre2AD D Z_Libran Browge...

Selent ICC Crrveter Manufarner and b aded

M_Ping_1 2 NS5 Dot Wew -
02_Piag_Tvin_0.£ 36 aul =
Aiakg hpre 03_Piog_Svin_0.5-3 6 ou
= 04_Piog_1 24r_0 755 Dvout Dabts |
05_Fited_48vin_1. S ou:
05_Figea]_T.0¥in_1 . 8oul
U ed_b5Vin_3. aut REETE -
MR_M =rrete_R Mk
03_Drzercte_2 2 ack
12 Drscrete_1.8vack
11 _D serete_1.2Vouk
12 Drzcrete_2. 2ok
14_Mog_WH_5Wir_0.0-2.2ou:
13_Piog_Wé_Tvin_0.8-3 3ol
13 Ping_Wres Pufie N8-3 ot
17_Piog_Yr_Bufir_".0 . 30 ow:

[1Ts

New DC-DC Converter Library File ErnTERE

PaC-Designer will create a library file for your DC-DC Converter

File name:  |Murata_1%2 _POL

2. The Select the DC-DC Converter Type dialog box (Figure 58) shows four
types of DC-DC converters:
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Figure 58: Selecting the DC-DC Converter Type

Select DC-DC Converter, Type @

Select the type of DC-DC Converter
" DC-DC Converter with Trim-up & Trim-0own Supply

—] ¥ Mo
DC-DC %
Converter
Trim

L

DC-DC Corveerter with Programmable
Output Yoltage

~ Programmable DC-DC Cornverter with
FRitrinn Connected to Yout

— ] Yn W —
Dc-bC

Corwerter

Trim
1T
— ] ¥n WV
DC-Dc .
Corwerter
FB

R
- inm

< Back | MNest > |

Cancel

DC-DC Converter with Trim-up & Trim-down Supply — This DC-DC
converter usually is available as a module with a fixed voltage. These
supplies can be margined up and down by connecting a resistor to
GND or to VOUT.

DC-DC Converter with Programmable Output Voltage — The output
voltage of these DC-DC converters is set by connecting a resistor
from trim pin to ground. The value of the resistor determines the
output voltage.

Programmable DC-DC Converter with Rtrim Connected to Vout — The
output voltage of these DC-DC converters is set by connecting a
resistor from its trim pin to its Vout terminal. The value of the resistor
determines the output voltage.

The Discrete implementation represents a class of DC-DC converters
whose output voltage is determined by two resistors: one between the
Vout terminal to the feedback node, and the second between the
feedback node and the ground.

Refer to the DC-DC converter datasheet to select the type of DC-DC
converter and click Next.
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3. Configure the DC-DC converter in the subsequent dialog boxes. The
below sub-steps describe how to use the dialog boxes to configure
different types of DC-DC converter.

a. Fixed Voltage - DC-DC Converter with Trim-up and Trim-down
Supply
Figure 59 shows the dialog box that appears when DC-DC Converter
with Trim-up & Trim Down Supply is selected in Figure 58. This type

of DC-DC converter is usually a module and is designed to provide a
fixed voltage.

Figure 59: Creating Library Element for a Fixed Voltage DC-DC
Converter

DC-DC Converter Datasheet Example Configurations

— ¥n Vau
oc-be Example
Carverter 3
Trim
T Example
= 182

Mominal Output Wolkage

With Trim Resiztor Open o] W

Yalues fram the DC-DC Converter D atazheet Exarmple Configuration Egquations

Examplel Example2 Example3

F to GHD F to GHD R toWout
Output Woltage with Trim
Resiztar Open | W | W | W
Trimmed/Margined Dutput Yoltage
with Trim R esiztar Connected |El W |El W |El W
Trir Resistor in ohms Required ta |EI slhie |EI ohms |EI s

Set Output Yoltage as Above

Comment: |

Save configurations to library file:

turata_1wZ_POL Save
< Back | Firizh | Cancel |

These supplies have a trim pin. This pin is used to margin the supply
up by 5- 10% or margin the supply down by 5-10%.

Nominal Output Voltage is the normal operating voltage of the DC-DC
converter when its trim pin is open. This is its normal operating state.

Next, there are two fields under the headings “Example 1 R to GND,”
“Example 2 R to GND,” and “Example 3 R to Vout.” Examples 1 and 2
are conditions used to generate a margin voltage that is different from
the nominal voltage. Different target voltages will require different
resistor values. These values are provided in the DC-DC converter
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datasheet, usually in a table format. Some datasheets provide a
formula to calculate these resistors. Enter the values of the target
output voltage and the values of the target resistors that are
connected between Trim and GND pins into the required fields.

The third column requires the value of the resistor to be connected
between the trim pin and the Vout pin of the DC-DC to achieve the
corresponding output voltage. Enter the resistor value and voltage
values in the required fields. Again, these values can be found in the
DC-DC converter datasheet.

After entering these values, enter the necessary comments that
describe the use of the DC-DC converter and click Finish. In this
case, the software creates a library element called
“Murtata_1V2_POL.”

Programmable Voltage with Resistor Connected from Trim Pin to
GND

Figure 60 shows the dialog box that appears when DC-DC Converter
with Programmable Output Voltage is selected in Figure 58.

Figure 60: Setting Reference Voltage/Current for the DC-DC Converter

DC-DC Conyverter Internal Vref Voltage @

Fleaze enter the internal Wref woltage, which is the trim pin output voltage with pin open

Tou cah enter gither

et |0,7525 W DC-DC Corvertar

FBO
Iﬁ P

e Wref

DD Carw erter
,7

FBO
EA —{ P

Rret
Iref

< Back | Nest > | Canhcel

All DC-DC converters use some type of reference voltage or current to
set the output voltage. The value of the reference voltage “Vref’ is
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shown either in the specifications section of the datasheet or in its
output voltage calculation formula. Sometimes, the datasheet shows
the architecture of the error amplifier with the value of Vref.

In some cases, the DC-DC converters use current reference instead
of voltage reference. The current reference value is accompanied by a
parallel resistor. Again, some DC-DC converter datasheets show the
equivalent circuit in the error amplifier section. After entering the Vref
or Iref & Rref values, click Next to get the dialog box shown in

Figure 61.

Figure 61: Configuring the Programmable Voltage DC-DC Converter
Library Entry

DC-DC Converter Datasheet Example Configurations

— v Yot [——
' ococ

Converter

Trim
L

Mominal Output Wolkage
With Trim Resiztor Open 0.7525 W

Yalues fram the DC-DC Converter D atazheet Exarmple Configuration Egquations

Examplel Example2 Example3

F to GHD F to GHD R toWout
Output Woltage with Trim
Resiztar Open | W | W | W
Trimmed/Margined Dutput Yoltage
with Trim R esiztar Connected |1 W |5 W | W
Trir Resistor in ohms Required ta |41 424000 ohms |1 472 ohms | s

Set Output Yoltage as Above

Comment: |

Save configurations to library file:

Murata OKYT3-072

< Back Firizh | Cancel |

The output voltage of these types of DC-DC converters is determined
by the resistor connected from their trim pin to GND.

To complete this dialog box, refer to the DC-DC converter datasheet
for a table that maps the resistor values connected between the trim
pin and GND to the desired output voltage values. In some cases, the
DC-DC datasheet provides a formula for calculating the output voltage
for a given trim resistor.

The first field is the output voltage of the DC-DC converter when the
trim pin is open. This is usually one of the entries in the table, or is
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calculated using a formula in the datasheet. The two examples
columns are also completed using the same table or the formula in the
datasheet of the DC-DC converter.

Note that one of the voltage values selected should be the maximum
output voltage and the second voltage value should correspond to the
minimum voltage. These voltage values need not be the actual output
voltage used in the circuit board.

Finally, enter the DC-DC converter model name (for example,
Murata_ OKYT3_D12) and save the file.

Programmable Voltage with Resistor Connected from Trim Pin to
Vout

Figure 62 shows the dialog box that appears when Programmable
DC-DC Converter with Rtrim Connected to Vout is selected in
Figure 58.

Figure 62: Setting Reference Voltage/Current for the DC-DC Converter

DC-DC Conyverter Internal Vref Voltage @

Fleaze enter the internal Wref woltage, which is the trim pin output voltage with pin open
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All DC-DC converters use some form of reference voltage or current
to set the output voltage. The value of the reference voltage “Vref” is
shown either in the specifications section of the datasheet or in its
output voltage calculation formula. Sometimes the datasheet shows
the architecture of the error amplifier with the value of Vref.
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In some cases, the DC-DC converters use current reference instead
of voltage reference. The current reference value is accompanied by a
parallel resistor. Again, some DC-DC converter datasheets show the
equivalent circuit in the error amplifier section. After entering the Vref
or Iref & Rref values, click Next to get the dialog box shown in

Figure 63.

Figure 63: Configuring the Programmable Voltage DC-DC Converter
Library Entry

DC-DC Converter Datasheet Example Configurations

— v Yot
nDC-DC
Converter
Trirm
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Mominal Output Wolkage
With Trim Resiztor Open

0.8 Y
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Examplel Example2 Example3

F to Yout F to Yout R toWout
Output Woltage with Trim
Resiztar Open | W | W | W
Trimmed/Margined Dutput Yoltage
with Trim R esiztar Connected |El W |El W | W
Trir Resistor in ohms Required ta |EI slhie |EI ohms | s

Set Output Yoltage as Above

Comment: |

Save configurations to library file:

POL_¥vZ

Save
< Back | Firizh |

Cancel |

The output voltage of these types of DC-DC converters is determined
by the resistor connected from their trim pin to GND. To complete this
dialog box, refer to the DC-DC converter datasheet for a table that
maps the output voltage to the resistor values connected between the
trim pin and Vout. In some cases, the DC-DC datasheet provides a
formula for calculating the output voltage for a given trim resistor.

The first field is the output voltage of the DC-DC converter when the
trim pin is open. This is usually one of the entries in the table, or is
calculated using a formula in the datasheet. The two examples
columns are also completed using the same table or the formula in the
datasheet of the DC-DC converter.

Note that one of the voltage values selected should be the maximum
output voltage and the second voltage value should be minimum

PAC-Designer Software User Manual

60



PAC-Designer Software User Manual

Creating a DC-DC Converter Library Entry

voltage. These voltage values need not be the actual output voltage
used in the circuit board.

Finally, enter the DC-DC converter model name (for example,
POL_XYZ) and save the file.

Creating a Library Entry for a Discrete DC-DC Converter

These types of DC-DC converters are common when they are realized
using switcher ICs, switching and filter elements. The output voltage is
programmed by connecting two resistors, Rfb and Rin. The output
voltage of the DC-DC converter is calculated using the formula:

Vout = Rfb*Vref / Rin. (Vref is the DC-DC converter reference voltage)

When the DC-DC converter used is of this type, the dialog box shown
in Figure 64 is used to create the library entry.

Figure 64: Creating a Library Entry for a Discrete DC-DC Converter

DC-DEC Converter Discrete Entry

L

1 Y W
DC-Dc Rt
Cornerter
FB
j Rin

Y alues internal o the DC-DC Converter
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Save configurations ta library file:
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< Back | Firish | Canhcel

The dialog box is completed by entering the Rfb and Rin values
calculated for a given output voltage, and Vref, which is found in the
datasheet.

Note that the number of resistors used for controlling these types of
DC-DC converters can be minimized by using the actual voltage that
is used on the board.
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4. Once the library entry is created, the next step is to associate the DC-DC
converter from the library to the trim pin. This is done using the following
procedure.

a. Start with the POWR1220AT8 schematic.
b. Double-click the Margin/Trim Block.
c. Double-click the Trim Cell of interest (for example, Trim Cell 1)

d. Set options in the dialog box shown in Figure 65 to design the resistor
network.

Figure 65: Calculating the Resistor Network for a DC-DC Converter

Trim 1 Configuration @

Schematic: Met harme: |Trim1

Ok
DC-DC Converter Murata_OKYT3D12 Irnpart DC-DC...
Cancel

Prafile 0 Mode |Closed Loop Trim

Target VWoltage Fealized Woltage DAL Code DALC Current

Yoltage Profile 0(0.0) [1.2 i 1198 W 2 -0.03 wh

Opticrs...
Vokage Prafile 100.1) [126 v 1285y 5 009w B
“ollage Profile 2[1.01 [1.14 W 1.140 4 10 003 uh Eror Details...

Woltage Profile 3(1.1] 1.2 W 1199 ¥ 2 003w
DAL Dutput Range [BFZ Waltage] 06D Y
ispPAC-POWR DC-DC
FipupDAL [in ahrms):
Open
winan+ [ 1 L Oute Int L— RpdnDAL [in ohms:
Open
Trim Riseries (in ohms):
[pAc >—0 . O Tim 2400000
Reeries RpupSupply (in ohms]:
Open
wnon- — Out- In- RpdnSupply (in ohms]):
~ l T j_J: Open

Schematic Net Name — The actual name of the pin in the schematic.

DC-DC Converter — Select the appropriate DC-DC converter from the library
by clicking Import DC-DC. In this example, Murata_ OKY3_D12 is selected.

Profile 0 mode — The pull-down menu selects the operating mode of the Trim
Cell: closed loop trim, trim using 12C interface with an external microcontroller,
and EECMOS value (open loop trimming).

Voltage Profile 0 — The nominal operating voltage of the DC-DC converter.

Voltage Profile 1 — One of the margining profiles. It can be the margin-up or
margin-down value.
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Voltage Profile 2 — The other margin profile. Again, this can be the margin-
down or margin-up voltage value.

Voltage Profile 3 — An additional profile provided for convenience. In some
cases, this can be used for additional margin testing.

After entering the required voltage values, click Calculate. The software
calculates the resistors to be placed between the Trim Cell output and the
DC-DC converter trim pin. Calculated DAC code values along with the DAC
currents for each of the profiles are also shown. When you click OK, these
values are stored into the source file.

The Options button opens the following dialog box (Figure 66) for fine tuning
the calculated resistor values.

Figure 66: Optimizing Resistor Values

Trim Configuration Options

El& Resiztor Standard

i

M aximum DAC Code Bange [1 - 127) +- 1110 Canicel
tax Supply Adjustment Range ’57 4

Attenuation Crossover Yoltage "197 W

Open External Resistor(z) Threshold ’M

Yhpz Selection m

EIA Resistor Standard — Limits the resistor selection to EIA 12, EIA24,
EIA48, EIA96, EIA192. It also provides a method to calculate the exact
resistor values. The selection of this option depends on design requirements.

Maximum DAC Code Range — Used to provide additional headroom in the
DAC code for maximum voltage variation. This is to account for the errors in
resistor values and the DC-DC converter inaccuracies.

Max Supply Adjustment Range — This is the maximum margin voltage
range with respect to the nominal value that is specified on profile 0. If the
design requires margining of 10%, this value is set to 10%.

Attenuation Crossover Voltage — The maximum input voltage for the ADC is
2.048V. If this ADC is used for measuring voltage higher than the Attenuation
Crossover Voltage, the on-chip 1:3 attenuator should be turned on. This
allows the maximum voltage input to the ADC to increase to 6.144V. This
entry sets the voltage at which the attenuator should be switched on.

Open External Resistor(s) Threshold — The maximum resistor value above
which the resistor is treated as an open circuit. This field can be used to force
the algorithm to minimize the number of resistors to the equivalent circuit. To
do that, first calculate the resistors using the default values. Change the Open
External Resistor(s) Threshold field to a value slightly higher than the series
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resistor value and click OK. The software automatically calculates the new
resistors and the associated DAC values.

Vbpz Selection — Usually it is best left as auto. In some cases, by forcing the
Vbpz values to one of the other voltages (0.6V, 0.8V, 1V, or 1.25V), the
number of resistors can be reduced.

After calculating the resistor values for all Trim Cells, the software
automatically saves all the values in to the .PAC file.

To generate a report file of all resistors connected to all Trim Cells, do the
following.

1. Choose File > Export to open the Export dialog box (Figure 67).

Figure 67: Generating a Report File for Margin and Trim

Export §|
Export What:
|Malgin.n’Tlim ﬂ ak.
In this farmat: LCancel
Ewport To:
{+ File:
" Clipboard

2. Under Export What, select Margin/Trim.

3. Click Browse to select the export file, and click OK.

The output text file format is as shown below:

MarginTrimCell

ldx 0

TrimCel INumberl
TargetVoutSP1 -200
TargetVoutSP2 -260
TargetVoutSP3 -140
TargetVoutSP4 .200

1

1

1

1
RealizedVoutSP1 1.198

RealizedVoutSP2 1

1

1

2

RealizedVoutSP3 .140
RealizedVoutSP4 .198
VdacCodeSP1 .000
VdacCodeSP2 -6.000

VdacCodeSP3 10.000
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VdacCodeSP4 2.000
Vref 0.752

Rbuffer 2561546.920
Rfb 14467007.127
Rin 1000000000.000
Invert 1
IsProgrammable 1
IsModule 1

IsRtGnd 1

Rseries 2400000.000
Rpdnl 10000000.000
Rpup2 10000000.000
Rpdn2 10000000.000
Rpupl 10000000.000
BPzZVoltage 0.600

BrickName Murata_ OKYT3-D12.xml

BrickFilename

TargetVdacCodesMax 110

EIAStdldx 1
LooseEIAStdIdx 1

AttenuationCrossoverVoltage
5.000000

MaxDeltaVoutPercent
RpdnOption O

1.900

Ropen 10000000.000000000000000

BPZSel 0.000000000001056
ResistorComputationAlgorithm

MarginTrimCell_end

1
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